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Introduction

NetWitness Investigate provides data analysis capabilities in RSA NetWitness® Platform, so that
analysts can analyze packet, log, endpoint, and UEBA data, and identify possible internal or external
threats to security and the IP infrastructure. This guide helps analysts perform investigations of endpoint
data using NetWitness Investigate.

Note: In Version 11.1 and later, the Hosts and Files views provide a view into endpoint data. Earlier
versions offer access to endpoint data using a standalone NetWitness Endpoint server.

For more information, see the NetWitness Endpoint Quick Start Guide, the NetWitness Investigate Quick
Start Guide, and the NetWitness Investigate User Guide.

Endpoint Metadata

Endpoint metadata is generated when hosts are scanned and when there are real-time activities on the
hosts. You can view the following categories of sessions when metadata forwarding is enabled:
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Operating | Scan

Windows

Linux

Categories

file, service,
dll, process,
task, autorun,
machine,
kernel hook,
image hook,
registry
discrepancies,
and
suspicious
threads

file, autrorun,
loaded
library,
systemd,
process, cron,
initd, and
machine

Tracking Categories

Process event - Reports any process related activities, such as
openprocess, openosprocess, createprocess,
createremotethread, openbrowserprocess.

File event - Reports any file related activities by an executable, such
as readdocument, writetoexecutable, renameexecutable,

selfdeleteexecutable, openphysicaldrive.

Registry event - Reports activities that result in registry creation or
modification, such as modifyservicesimagepath,
modifyfirewallpolicy, createservicesimagepath,
createsecuritycenterconfiguration,
modifybadcertificatewarningsetting.

System event - Reports IP change and boot events.

Network event - TCP/UDP and incoming/outgoing.

« Reports outbound and inbound network connections on all
supported Windows platforms.

« Reports IPv4 and [Pv6 connections.

Console event (for Windows 8 and later) - User input that is entered
into a console application, such as cmd . exe, powershell .exe, is
captured and reported with the context console.local.

Commands executed by cmd. exe, powershell.exe as a result of
inter-process communication through anonymous pipes are captured
and reported with the context console. remote.

For example, Get-Ttem -Path Registry::HKEY LOCAL
MACHINE\SOFTWARE\Microsoft\Windows\

CurrentVersion.
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Operating | Scan
Tracking Categories

Categories

Mac file, daemon, e Process event - Reports any process related activities, such as
process, task,
dylib, autorun,
and machine

openprocess, createprocess, Openosprocess,
openbrowserprocess, allocateremotememory,
createremotethread.

« File event - Reports any file related activities by an executable, such
as writetoexecutable, renameexecutable, createautorun,
deleteexecutable, selfdeleteexecutable, writetoplist,

writetosudoers, createbrowserextension.
o Network event - TCP/UDP and incoming/outgoing.

o Reports outbound and inbound network connections on all
supported Mac operating system.

« Reports [Pv4 and IPv6 connections.

For more information on metadata, meta keys, meta values, and meta entities, see the NetWitness
Investigate User Guide.

Risk Score

Analysts can use the risk score to begin an investigation on hosts and files. RSA uses a proprietary
algorithm to calculate the risk scores ranging from 0 to 100. A subset of alerts associated with hosts and
files contribute to the risk score calculation. Analysts can review critical and high alerts associated with
a risk score to identify strong evidence of malicious activity and take required action.

Note: If you have an Insights agent, you can view the risk score for files but not for hosts. To view the
risk score for hosts, upgrade to the Advanced agent. For more information, see the NetWitness
Endpoint Configuration Guide.

The following factors contribute to the risk score:

« Distinct Alerts. Any host or file activities that are suspicious or malicious generate alerts. Only the
distinct alerts are used for risk score calculation.

« Severity of Alerts. Severity of alerts, such as critical, high, and medium.
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afewseconds ago

DETAI FILES  DRIVERS  LIBRARIES

[ALERTS SEVERITY

2

CRITICAL

28 events

Blackdisted File (28)
28 event(s)

20 13:40:54.000

FILENAME

All the distinct alert shown in the above example can be for the

ANOMALIES

This figure is an example of a host with 2 Critical, 10 High and 12 Medium distinct alerts.

NT V

115.00

HOT TIME

DOWNLOADS

CATEC
File

evenTTYPE
Endpoint

GUMENT

EvenTTYPE
Endpoint

A

evenTTvPE
Endpoint  File

LAUNCH ARGUMENT

SYSTEM INFO

06/24/2020 21:30:33

HISTORY

® Events rolled over due to retention policies or manual deletion will not be available.

HOST DETAILS

Show detail: h values only

Windows-security

2

Administrators

Intel(R) 825741 Gigabit Network...
00: 6:01:29:06

same file or different files. For

example, Configures Image Hijacking alert is triggered for files, such as malware4.exe and

malware’.exe.

RSA

AGENT SCAN STA

Idle

T LAST SEEN

afewseconds ago

windows

DETAILS AUTORUNS  FILES  DRIVERS  LIBRARIES

ALERTS SEVERITY

2 10

CRITICAL

12 events
12

HIGH | meoium EVENTTIME  EVENT
03/01/2019 [
) e 02:33:08.000 "
Configures Port Redirection (1) =
1 event(s)

FILENAME

Creates Shadow Volume For Logical Drive (1)

SOURCE  malware7.exe

1 event(s)
TARGET

REG.exe
Creates Remote Process Using WMI Command-Line Tool (1)
1 event(s)

Enables RDP From Command-Line (1) CENTTIME  EVENT
03/01/2019 'E*r:’;po
02:03:08.000

pm

1 event(s)

Configures Image Hijacking (12)

12 event(s)
FILE NAME

Stops Security Service (1) SOURCE  malware3.exe

1 event(s) TARGET

REG.exe
Creates Remote Task (4)

4 event(s)

ANOMALIES

CATEGORY
Process Ev... createProc...

CATEGORY
Process Ev... createProc...

AGENT VERSION

11500

PSHOT TIME

DOWNLOADS

ACTION HOSTNAME

INCH ARGUMENT

malware7.exe -dll:ioc.dll -testcase:400,401

REG
KLM\SOPI’WARE\M\(rOSOIl\W\ indows

NT\Currentyersion\mage Fil Execution
(\DnS\SE‘h( exe" /v,

AcTION HOSTNAME

LAUNCH ARGUMENT

malware3.exe -dll:ioc.dll -testcase:400,401

REG.e
A VS ORTWARE Wicrosoft\Wi ndows
NT\CurrentVersion\image File Executior

.exe” NV Debuggev JtREG 52 /d

ons\magni
oy eI e T

SYSTEM INFO

-WIN-NMUFVI3DGTN\e..

WIN-NMUFVI3DG... WIN-NMUFVI3DGTN\e...

06/24/2020 21:30:33

HISTORY

@ Events rolled over due to retention policies or manual deletion will not be available.

HOST DETAILS  POLICY DETAILS

Type to filter list
USER ACCOUNT

e
Show details with values only
Use
PATH
C:\Users\ecat\Desktop\!

C:\Windows\system32\
true

er /t REG_SZ /d
windows\system32\cm

Administrators

USER ACCOUNT NG
svsvm

indows

1

PATH

C:\Users\ecat\Desktop\ false

C:\Windows\system32\
rk Interfac

Intel(R) PRO/1000 MT Networ...

This figure is an example of files with distinct alerts. Each file can have a multiple distinct alerts. The
files can have a same alert name being triggered by two different hosts as shown below.
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Details  Analysis

ACTIVEON  SIGNATURE  SIZE FILE STATUS  OPERATING SYSTEM
82 2 unsigned 120KB  Neutral mac

ALERTS SEVERITY @ Events rolled over due to retention policies or manual deletion will not be available.

3 events
EVENTTIME  EVENTTYPE  CATEGORY  ACTION  HOSTNAME USERACCOUNT  OPERATING SYSTEM Type to filter list
HIGH | mepium (L 02/27/2019 Endpoint  File . mac '
10:45:50.000 Show details with values only
Packed And Network Access (1) am

FILE DETAILS  HOSTS

General

jlleventCy FILE NAME LAUNCH ARGUMENT
.MSProc
Hidden Plist And Autorun (3) SOURCE
3eventls) TARGET 6.631475448608398
Packed And Autorun (3) EVENTTIME  EVENTTYPE  CATEGORY ACTION  HOSTNAME USERACCOUNT  OPERATING SYSTEM 120k8
02/27/2019 Endpoint  File b L mac

10:45:50.000
am

3 event(s) st macho

Signature
FILE NAME LAUNCH ARGUMENT 2

SOURCE Features unsigned

TARGET

EVENTTIME  EVENTTYPE CATEGORY  ACTION HOSTNAME USER ACCOUNT OPERATING SYSTEM

mac | 5171a462210f540a3005e361c...
2369375ff825f6dSee9bcd296...

02/27/2019 Endpoint File
09:35:46.000
am

56 5d0b9421c46b1d91677791d6...

FILE NAME LAUNCH ARGUMENT

Besides the above factors, the risk score is reset when you perform any of the following actions:

o Whitelist or blacklist a file after investigation. The risk score of a file is set to 0 on whitelisting and
set to 100 on blacklisting.

o Ifthe alerts or events triggered by the host or files on the host are false positive, you make changes to
the Endpoint Application rules or ESA rules and reset the risk score.

Note: When you whitelist a file or reset the risk score, the alerts that contributed to the risk score are
not shown in the Host Details tab.

The host risk score depends on the risk score of all the files on the host. When you change the file status
or reset the file risk score, the host risk score is recalculated. For example, the score for all the hosts on
which a blacklisted file is present is recalculated and becomes 100. If the host is not found to be
infected, you can reset the host risk score. This deletes the alerts contributed to the risk score and does
not impact the global file score. For more information on changing the file status, see Changing File
Status or Remediate.

Note: For the risk score calculation, the ESA Correlation server must be configured with an Endpoint
Concentrator. The application rules are automatically deployed on installation. For an upgrade, you
must deploy the application rules from RSA Live. For more information, see the NetWitness Endpoint
Configuration Guide.

Note: For the accurate risk score calculation, the default multi-valued meta keys are required on the
ESA Correlation service. For more information, see "Configure Meta Keys as Arrays in ESA
Correlation Rule Values" section in the £SA Configuration Guide.

Severity of Alerts

The following table depicts the risk score range based on the associated alert severity:

10 Introduction



NetWitness Endpoint User Guide

Risk Score

Severity

Range
Critical 100
High Orange 70-99
Medium Yellow 31-69

Low 0-30

The following is an example of alerts contributing to the risk score:

ALERTS SEVERITY c
2 events

3 1 6 2 0 3 9 EVENT TIME EVENTTYPE CATEGORY ACTION HOSTMNAME

01/02/2019  Log Process ... createPr... SUPEmo..
06:23:42.000
am

USER
ACCOUNT
CRITICAL HIGH ' MEDIUM ALL :

Enables Cleartext Credential Storage (2)

2 event(s)

FILE NAME LAUNCH ARGUMENT PATH

SOURCE dtf2.exe dif2.exe dilicc.dll C{LUSﬁ_rs
Exports Sensitive Registry Hive (4) =archi
4 event(s) TARGET REG.exe REG.exe ADD C\Wind:
) HELM\System\CurrentControlSe
Sea TV DT ORONCREDERTIAL,
5 i S5 est /\ USELOG 1
Enables Login Bypass (12) REG DWORD /D 1 /&

12 event(s)

EVENT TIME EVENT TYPE CATEGORY ACTION HOSTMNAME EEE_FE o
(4]
01/02/2019  Log -

06:23:42.000
am

FILE NAME LAUNCH ARGUMENT PATH

SOURCE dtf2.exe dif2.exe -dil:ioc.dll C:\Users
el\archiv

In the above example, there are three distinct critical alerts. For each alert type, associated events are
displayed. You can see that the "Enables Cleartext Credential Storage" alert was triggered twice. The
details of the two events are displayed with the metadata information. For more information on severity
alerts and metadata information, see Analyze Hosts Using the Risk Score and Analyze Files Using the
Risk Score.

Global and Local Risk Score
Analysts can get better context on file activities on hosts using the global risk score and the local risk
score of a file.

Global Risk Score - The global risk score is an aggregate of all suspicious and malicious activities
performed by the file across all hosts. This score indicates the potential threat posed by the file across
the NetWitness Platform.

Local Risk Score - The local risk score is calculated on suspicious or malicious activities performed by
the file on a specific host. The local risk score is used for the host risk score calculation.

For more information on the global and local risk score, see Investigating Files and Investigating Hosts.
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Automated Incident Creation Based on Risk Score

By default, a threshold is set for the risk score to control the generation of incidents and alerts in
NetWitness Respond. For more information on configuring the threshold limit, see the NetWitness
Respond Configuration Guide.

File Reputation

The File Reputation service available on RSA Live checks the reputation of every file hash against an
extensive database of known file hashes updated in real-time. The file reputation is displayed on the
Investigate and Respond views.

The reputations for a file hash are:

Malicious File hash is labeled as malicious.
Suspicious File hash is suspected to be malicious.
Unknown File hash is not known.

Known File hash information is known to the file reputation service and does not have any
previous bad record.

Known Good  File hash information is known good, such as files signed by Microsoft or RSA.
Invalid File hash format is invalid.

The suspicious or malicious files are available for further analysis in the Investigate > Navigate view
and Investigate > Events view. For more information on the file reputation service, see the Live
Services Management Guide.

Note: The File Reputation service supports maximum of 10 million files for a reputation of file hash.

File Status

To help analysts triage and focus on their investigation, NetWitness Platform provides capabilities to
manage suspect and legitimate files. For example, you can whitelist files that are legitimate (such as
security products), or blacklist files based on known threats and investigation.

A file can be classified as follows:

o Blacklist: File that is marked suspicious, such as when ransomware is found by scan.

Graylist: File that is marked for a later review.
o Whitelist: File that is legitimate and is not to be considered for risk scoring.

o Neutral: Default status.

For more information, see Changing File Status or Remediate.

12 Introduction



NetWitness Endpoint User Guide

Remediation

If a file is malicious or infected, you can block the file to prevent future execution on any host.
Remediation helps to:

« Stop or reduce the spread of identified malware, such as viruses, trojans, rootkits, worms, spyware,
and adware.

« Identify attempted breach points to aid in deeper analysis; all events are time-stamped allowing
analysts to trace backward to identify the entry point.

« Remove unwanted software, such as adware, which can potentially mask real malware.

« Stop all actions possible by the loader.

You can block files with the following file extension: EXE, COM, SYS, DLL, SCR, OCX, BAT, PSI,
VBS, VBE, and VB. For more information, see Changing File Status or Remediate.

Network Isolation

If you suspect that a host is potentially compromised with the threat still being active, you can isolate the
host from the network and safely investigate possible threats within the host. By isolating the host, you
can control the spread of an attack and analyze the malware behavior. When a host is isolated, only
connection to the following IP addresses are allowed:

« Endpoint Server, Relay Server, DNS, DHCP, Gateways, 0.0.0.0, and 255.255.255.255.

o Other IP addresses that you include in the exclusion list.

In the isolated state, all events are reported to the Endpoint Server retaining full visibility into activities
on the host. You can continue investigation by requesting scans, downloading MFT, files, and so on. The
following metadata is added to the network events:

o network.isolated - indicates that the host is isolated.

o network.connectallowed - indicates that the network connection is allowed as the IP address is
included in the exclusion list.

« network.connectblocked - indicates that the network connection is blocked.

Note: If the agent is enabled for log or file collection, make sure that you add the Log Decoder IP
addresses in the exclusion list while you isolate the host.

For more information, see Isolating Hosts from Network.
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Focusing on Endpoint Analysis

This guide provides the information needed to conduct an investigation that is focused on endpoint data
from configured hosts. Analysts who conduct analysis using Investigate need to have the appropriate
system roles and permissions set up for their user accounts. An administrator must configure roles and
permissions as described in Roles and Permissions for Endpoint Analysts. For more information on roles
and permissions, see the System Security and User Management Guide.

To hunt for information on hosts that have the agent running, begin the investigation in the Hosts view
(Hosts). For every host, you can see processes, drivers, DLLs, files (executables), services, anomalies,
and autoruns that are running, and information related to logged-in users. (See Investigating Hosts.)

You can begin the investigation on files in your deployment in the Files view (Files). (See Investigating
Files.)

Note: To access the Hosts and Files views, you must have the endpoint-server.filter.manage
permission.

Analysts use the Hosts and Files views to investigate or perform analysis on hosts or files using
attributes such as IP address, host name, Mac address, risk score, and so on. This figure shows the high-
level capabilities of an endpoint investigation. The top box are all the possible starting points, and the
lower box shows the tasks that you can accomplish from different starting points.

14 Focusing on Endpoint Analysis
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Begin or Continue an Investigation in the Investigate View or Pivot from the Respond View

Browse Event
Metadata

(Navigate View)

Analyze Suspicious
Files
(Files View)

Analyze Raw Events
and Metadata
(Events Analysis

View)

Identify High Risk

User

(Users View)

Analyze Files and

Processes on Hosts

(Hosts View)

Triage an Incident

(Pivot from Respond

View)

Acton a Network, Log, or Endpoint Event, or on a User Behavior

Reconstruct an Event

Investigate Process

Analyze Events

Export Hosts
Attributes and Global
Files

Remediate

Create an Incident in
Respond

Perform Internal
Lookups

Analyze Downloaded
Files

Analyze Downloaded
MFT

Isolate Host from
Network

Analyze Risk Score
for Files and Hosts

Analyze Risky Users
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Download Process
Dump or System
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Analyze Hosts/Files
with File Acitivity

Perform External
Lookups

Analyze Certificates

Change File Status or
Remediate

Focusing on Endpoint Analysis
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Investigating Files

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

The Files view provides a holistic view of all files in your deployment. You can apply various filters,
sort, and categorize files into different status to reduce the number of files for analysis and identify
suspicious or malicious files.

Best Practices

The following are some best practices and tips that may help you investigate efficiently to identify and
isolate threats or attacks:

Analyze Events
== |Navigate or Event
Analysis View)

Whitelist Files/ ;
Certificates Signed by GRS Download Files for
Known Good Identlfy‘Flle-s for Analyze Files —= Deeper Analysis mm.a Change File Status Remediate
Investigation
Vendors

Perform External

—-

Lookups

« Whitelist all files signed by RSA, Microsoft, and any other known good vendors. Use the filters to list
the files and change the status of all these files to whitelist. For more information, see Filter Files and
Changing File Status or Remediate.

Note: Some Microsoft signed files are restricted from whitelisting as there is a potential risk of
them being used for malicious purposes. To view the list, see Files Restricted from Whitelisting,

« Change the status of certificate and the associated files automatically. For more information, see
Analyze Certificates.

« Filter to exclude whitelisted, files with valid signature, known good files based on reputation status.
For more information, see Filter Files.

o Lookup Google or VirusTotal with the filename or hash to get more information about a suspected
file. For more information, see Launch an External Lookup for a File.

o Analyze the files using one or more of these indicators:

a. Risk score - Displays the risk score for a file. Analysts can view the associated alerts and events
for further investigation. For more information, see Analyze Files Using the Risk Score.

b. On Hosts - Indicates the number of hosts on which a file exist. If a file is present on fewer hosts
with a high risk score, it may require further investigation. You can also sort or filter using On
Hosts column to narrow down the search during investigation. For more information, see Analyze
Hosts with File Activity.
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c. File status - To manage suspected and legitimate files, analysts can use the file status to manage.
For more information on the various file status, see Changing File Status or Remediate.

d. Reputation status - Indicates the reputation of a file hash for analyst to narrow-down the files to
investigate. For more information, see File Reputation.

e. Signature - A valid signature on a file signed by a trusted vendor, such as Microsoft and Apple
indicates that the file is not a risk. If a file is unsigned, it may be malicious, and needs
investigation.

f. File name - Many trojans write random file names when dropping their payloads to prevent an
easy search across the hosts in the network based on the filename. For example, if a file is named
svchOst.exe, sevhost.exe, or svchosts.exe, it indicates that the legitimate Windows file
named svchost.exe is being mimicked.

« Investigate a particular file name or hash by pivoting to Navigate or Events view to view context, file
activity on different hosts, and any file transfers across the network through packet data. For more
information, see Analyzing Events.

« Download suspicious files to the server for deeper analysis. For more information, see Analyzing
Downloaded Files.

« Change the status of the file (blacklist or graylist), and block an infected or malicious file. For more
information, see Changing File Status or Remediate.

View Files

You can view all files present on a specific Endpoint server or consolidated list of all files on multiple
Endpoint servers using the Endpoint Broker for analysis. To view files:

1. Go to Files.
2. Select one of the following:

RSA

Y Filters 8 endpointloghy... View Certificates % Change File Status [ Analyze Events | v % More Actions v

endpointbroker - Endpoint Broker Server

T BT . . ’ SEENTIME  ON HOSTS REPUTATION SIZE SIGNATURE PE.RESOURCE... FILE STATUS
endpointloghybrid1 - Endpoint Server

Select

| endpointioghybrid2 - Endpoint Server }/2020 170.. 2 Known Good 9.5MB  microsoftsignedvalid Microsoft Cor... Neutral

S TERAE 06/11/2020170... 2 Known Good 1439.. microsoftsignedyalid MicrosoftCor... Neutral

Equals g. File 06/11/202017:0... 2 Known Good 3627... microsoftsignedvalid Microsoft Cor... Neutral

e 06/11/2020170... Known Good 6590... microsoftsignedvalid ~Microsoft Cor... ~Neutral
STATUS

O Neutral 06/11/2020 17:0... Known Good 567KB  microsoft;signedyalid ~ Microsoft Cor... ~Neutral
O Blacklist
O Graylist ) 06/11/2020 17:0... Known Good 802.6... microsoft;signedyalid ~Microsoft Cor... ~Neutral

O Whitelist
06/11/2020 17:0... Known Good 135KB  microsoftsignedyal.. MicrosoftCor... Neutral

REMEDIATION 06/11/202017-0... Known Good 7475... microsoftsignedval.. Microsoft Cor... Neutral

O Blocked
06/11/2020170... Known 815KB  signedyalid VMware, Inc. Neutral

06/11/2020 17:0... Known 59.5KB  unsigned - Neutral

0O Suspicious 06/11/202017:0... Known 1113.. signedyalid Microsoft Cor...  Neutral
O Unknown
@) s 06/11/202017-0... Known 0...  unsigned VMware, Inc. Neutral
0O Known Good

O Invalid 06/11/202017:0... Known Good microsoftsignedyal.. Microsoft Cor... Neutral
nvali
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o Endpoint Broker Server to view all files across all Endpoint servers.

« Endpoint Server to view files on a specific Endpoint server.

Select the file that you want to analyze.

4. Click a row to view the following details:

Files

Filters || © endpointioghy... v || ViewCertificates & Change FileStatus | | &7 AnalyzeEvents |+ | [ § . i} emd.exe

FILE DETAILS
) FILE NAME RISKSCORE  +  FIRST SEEN TIME ON HOSTS REPUTATION SIGNATURE PERESOURCES.C_  FILE STATUS

11/08/2019 10:51:0. microsoft signedvalidca . Microsoft Corpor..  Neutral
11/08/2019 10:49:3. microsoft signedvalidca . Micrasoft Corpor.
11/06/201902:422 microsoft signedvalidca . Microsoft Corpor.
11/06/201902415_. microsoft signedvalid.ca_  Microsoft Corpor...
11/17/2019 10245 -

11/11/201906:59:4.

11/10/201909:51:1

11/06/201902:424.
microsoftsignedyalidcatalog
03/19/201903:59:28.400 am

11/06/2019 024135,

11/06/2019 02,4135,
2e9c12e54763822eec42474983.

11/08/201910:521. Mecrosoft W

11/11/2019 12314,

« File Details displays the file information. For more information, see Launch an External Lookup
for a File.

« Risk Details displays the distinct alerts associated with the risk score. For more information, see
Analyze Files Using the Risk Score.

o Hosts displays the number of hosts on which file activities are present. For more information, see
Analyze Hosts with File Activity.

Filter Files

You can narrow down the investigation by filtering files using file name, on hosts, file status, risk score,
remediation, reputation status, operating system, size, entropy, format, signature, company name,
checksum (MD5 and SHA256), and downloaded status.

Note: While filtering on a large data set, use at least one indexed field with the Equals operator for
better performance. The following fields are indexed in the database - Filename, MD5, SHA256,
Operating System, First Seen Time, Format, File Status, On Host, and Reputation Status.

18 Investigating Files



NetWitness Endpoint User Guide

RSA

¥ Filters x Sendpointioghy. ~ || ViewCertificates | | [ % ClangeFilestatus | [ 7 AnalyzeEvents |~ | [ § More - |

L] FILE NAME RISK SCORE + FIRST SEEN TIME ON HOSTS REPUTATION
O 100 1108201910510 1 -
O 1108201910493 1 -
11/06/20190242:2 . -
11/06/20190241:5..

11/17/2019 10:24:5_

11/11/201906:59:4...

11/10/201909:51-1.

11/06/20190242:4..

11/06/2019 02415

11/06/201902415_

11/08/201910:52-1 .

11/11/2019 12314

11/11/201912:31:4..

11/08/2019 10:54-1

11/08/201910:54-1

11/08/201910:52-1 .

11/08/2019 10:52-1 .

O
O
O
0
O
O
O
O
0
O
O
O
O
O

1108/201910:52-1

Select the parameters in the Filters tab. Click Save to save the search and provide a name (up to 250
alphanumeric characters). The filter is added to the Saved Filters list. To delete a filter, hover over the

name and click W

Note: Special characters are not allowed in the filter name except underscore () and hyphen (-)
while saving the filter.

For example, to filter the files based on file reputation, select the reputation status in the Filter panel.

Note: For the file size, 1 KB is calculated as 1024 bytes. For example, if the actual size of the file is
8421 bytes, the UI will display it as 8.2 KB instead of 8.22 KB. It is recommended to search using the
bytes format when using the Equals operator.

Add and Sort Columns in the Table

By default, the Files view displays a few columns, and files are sorted based on the risk score. To add or
remove columns:

1. Go to Files.

2. Select the columns by clicking <3 in the right-hand corner.
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File Status
Remediation
Reputation

Downloaded

SignatureTimestamp

mature Thumbprint

3. Scroll down or enter the keyword to search and select the required columns.

4. To sort the column in ascending or descending order, click the arrow on the column header.

Analyze Files Using the Risk Score

To analyze files using the risk score:
1. Go to Files.

The Files view is displayed.

2. In the Server drop-down list, select the Endpoint server or Endpoint Broker server to view the files.

3. Select the file and do any of the following.
o Click a row to view the risk associated with the file in the Risk Details panel.
« Click the hostname to investigate the host.
The Details tab is displayed.

4. Inthe Alert Severity panel, click the alert severity, such as Critical, High, Medium, or All
The list of distinct alerts is displayed along with the total number of events associated with the alert.

5. Click an alert to view the associated events.

Note: Only the latest 1000 events are displayed.

6. To view all the metadata associated with a specific event, click the event header. The information
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such as source path, target path, filename, and others is displayed.

@ Events rolled over due to retention policies or manual deletion will not be available.
6 events

even e event vee carecony Acrion HosTuAE o s
CRITIcA HieH Jueoiom ALt 03/01/2019 Endpoint Process Event createProcess — windows Oeda8ba34ddc46909c66cebasbc231f029dedbc0992a1eb31130b794134c55db
02:34:08.000 pm
Enables Login Bypass (6)

6 eventls) EVENT SOURCE

10.40.14.52:50005

DOMAIN/HOST
WIN-NMUFVI3DGTN

size USER SRC

FILE SHA256 a1

193160426600b776d9b2a055903d8cbc8foea

1520e9c2a7e6d5960b6faddcat DATA ALIAS IP
FILENAME

malware10.exe

SOURCE il
P

ATH
C\Users\ecatiDesktop\

CWindowsystem32\

FILE SHAZS6
Oeda8ba34ddca6909c66cebasbc231f029dedbe
0992a1eb31130b794134c55db

FILENAME FILENAME

malware10.exe REG.exe EVENT SOURCE ID

size 118794

LAUNCH ARGUMENT LAUNCH ARGUMENT 0

malware10.exe -dlkioc.dll -testcase:400,401 ADD USER
e FTWAREMicrosoftWindow: HasH v

DEVICE MCurrentversion\image Fie Execution
Oplmns\dup\a switch.exe” vV Debugger /t
B R owsystemanci et 1

Oedagba34ddcd6909c66cebasbc2311029d
edbc0992a1eb31130b794134c55db

useR ence TID
userAME 93B4DD24-9103-9752-FOB5-FE6141338C91
WIN-NMUFVIZDGTNecat

DEVICE TYPE
P 1931 6cH265d0b77605b2a0505903dchcBfoea EeEipcht
OedaBba34ddcA6909cscebasbc231f029dedbe 2
0992a16b311300794134c55db et taa ]

RELATED LINKS

03/0172019 Endpoint createProcess WIN-NMUFVI3DGTN WIN-NMUFVI3DGTN\ecat windows Oeda8ba34ddca6909c66cebasbc2317029dedbc0992a1eb31130b794134cs5db
8.000 pm

7. Hover over one of the meta values for IP, Hostname, Mac, File name, File hash, User, and Domain
to view additional information about the specific metadata. A hover box displays a list of the data
sources that have context data available for meta value. These are the possible data sources:
NetWitness Endpoint, Incidents, Alerts, Hosts, Files, Feeds, and Live Connect.

CONTEXT HIGHLIGHTS

] ]
INCIDENTS ALERTS

ACTIONS

£ Add/Remove from List

Q, Pivot to Investigate > Navigate
View Context

USER ACCOUNT
WIN-NMURFVI3DGTN\ecat

OPERATING S5YSTEM
windows

8. To investigate the original event and destination domain of the event, do any of the following:

1 3 5

| mepium

@ Events rolled over due to retention policies or manual deletion will not be available.
6 events

USER ACCOUNT OPERATING SYSTEM

windows

EVENT TIME
03/01/2019
02:34:08.000 pm

EVENTTYPE CATEGORY ACTION
Endpoint Process Event createProcess

HOSTNAME

CRITIC, c HAsH
CRITICAL HIGH Oeda8ba34ddc46909)|

Enables Login Bypass (6)
6 everls) SOURCE TARGET

PATH PATH
cawindows\system32\

DOMAIN/HOST

C:\Users\ecat\Desktopy
SIZE

FILE SHA256

OedaBba34ddc46909c66ceba: 5bc231 f029dedbc
0992a1eb31130b794134c55db

FILENAME
malware10.exe

LAUNCH ARGUMENT
malware10.exe -dll:ioc.dll -testcase:400.401

DEVICE

USER
USERNAME

HASH
Oedagba34ddc46909c66cebasbc231f029dedbe
0992a1eb31130b794134c55db

RELATED LINKS

FILE SHA256

19316d4266d0b776d9b2a05d5903d8cbcsf0ea
1520e9c2a7e6d5960b6faddcaf

FILENAME
REG.exe

LAUNCH ARGUMENT
REG.exe ADD
"HKLM\SOFTWARE\Microsoft\windows
NT\CurrentVersion\Image File Execution
Option: s\dlsplayswnch exe" /v Debugger /t
REG_SZ /d "C:\windows\system32\cmd.exe” /f

DEVICE
HASH

19316d4266d0b776d9b2a05d5903d8cbc8f0ea
1520e9c2a7e6d5960b6faddcal

41

DATA
FILENAME
malware10.exe

SIZE

41

HASH
0OedaBba34ddc46909c66cebashc231f029d
edbc0992a1eb31130b794134c55db
AGENTID
93B4DD24-9103-9792-F985-FE6141338C91

DEVICE TYPE
nwendpoint

o To reconstruct an event in a readable form that matches the original, click the Investigate

Original Event link highlighted in blue. For more information on event reconstruction, see the
NetWitness Investigate User Guide.

« For details about the elements associated with an event, click the Investigate Destination
Domain link highlighted in blue. For more information on Contextual Information for an Event, see
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the NetWitness Investigate User Guide.

Note: Investigate Destination Domain link is not displayed if there is no domain.dst event.

« To view a list of processes captured on the hosts and investigate a particular process, click the
Analyze Process link highlighted in blue. For more information on process analysis, see
Investigating a Process.

Note: Analyze Process link is not displayed if there is no createprocess event.

Analyze Hosts with File Activity

To view the list of hosts on which a file exist, do the following:

Note: By default, the system detects the best data source for the On Hosts aggregation. To change the
data source, in the Explore view, modify the investigate service ID under endpoint/investigate.

1. Inthe Files tab, click the row for the file you want to analyze.

2. In the right panel, click the Hosts tab. The list of hosts along with the risk score are displayed.
RSA n ate  Respond sers  Hosts  Files

¥ Filters ‘ S endpointloghy... v || View Certificates & Change File Status || (7 Analyze Events | v H ¢ More Actions v/
sk scone 1

ST SEEN TIME N HOSTS REPUTATION

06/11/202017:05:... Known Good

06/11/202017:05:...

06/11/202017:05:...

06/11/2020 1

06/11/202017:05:... 2

06/11/2020 17:05...

3. Click the host name to open the host details.

A : : : : :
4. Click to analyze events on the host in the Events view. For more information, see Analyzing
Events.

Launch an External Lookup for a File

While analyzing a file, you can search Google or VirusTotal with the filename or hash to get more
information about the file. To launch the search:

1. Go to Files.
2. View the details of the file name and hash from the table MD5, SHA1, and SHA256 columns, or
view the details in the File Details tab on the right panel.

3. Select one or more files, and right-click or in the More Actions drop-down list in the toolbar, do the
following:
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Y Filters & endpointloghy... v View Certificates & Change File Status [ Analyze Events | v ¢ More Actions v/

SAVED FILTERS [0 FILENAME RISKSCORE T FIRSTSEENTIME  ON HOSTS REPUTATION SIZE SIGNATURE PE.RESOURCE... FILE STATUS

Select Known Good 9.5MB  microsoft,signedyalid Microsoft Cor... Neutral

Change File Status

. Known Good 1439.. microsoftsignedyalid Microsoft Cor... Neutral
FILE NAME

Analyze Events

Equals e.g. Filename.d Known Good 362.7.. microsoftsignedyalid MicrosoftCor... ~Neutral
g = Google Lookup GEEE

VirusTotal Lookup Known Good 659.0... microsoftsignedyvalid Microsoft Cor...  Neutral
FILE STATUS
O Neutral B Known Good 567KB  microsoftsignedvalid Microsoft Cor... Neutral
O Blacklist )
O Graylist Download File to Server Known Good 8026... microsoftsignedyalid MicrosoftCor... Neutral

O Whitelist
Known Good 135KB  microsoftsignedval.. MicrosoftCor... Neutral

REMEDIATION Known Good 7475... microsoftsignedyal... MicrosoftCor... Neutral
O Blocked

Reset Risk Score N )
Known 815KB  signedyalid VMware,Inc.  Neutral

a. Select Google Lookup and perform a search on the filename, MDS5, SHAT1, or SHA256.
b. Select VirusTotal Lookup and perform a search on MD5, SHA1, or SHA256.

Note: To open files in multiple tabs, make sure you enable the pops-up in the browser.

Set Files Preference

By default, the Files view displays a few columns and the files are sorted based on the risk score. If you
want to view specific columns and sort data on a specific field:

1. Go to Files.
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2. Select the columns by clicking E=3 in the right-hand corner. The following example shows the drop-
down list displayed while adding columns:

File Status
Remediation

Reputation

Downloaded

3. Sort the data on the required column.

Note: The selections you make here become your default view every time you log in to the Files view.

Export Global Files

To extract the list of global files to a comma-separated values (csv) file:

Note: While filtering on a large data set, use at least one indexed field with the Equals operator for
better performance. You can export up to 100k files at a time.

1. Go to Files.

2. Filter the files by selecting the required filter option.

3. Add columns by clicking Ed in the right-hand corner.
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4. Click to export the files to a csv file.
RSA n Users Files

Y Filters 8 endpointioghy... \ View Certificates @ Change File Status || ¢ AnalyzeEvents | v || § More Actions v

VED FILTERS FILE NAME RISKSCORE 1 FIRSTSEENTIME  ONHOSTS REPUTATION sizE SIGNATURE PERESOURCES... FILE STATUS

Select (0) 06/11/202017:05-... Known Good 95MB  microsoftsignedyalid  Microsoft Corpo... Neutral

SIS 06/11/202017:05:.. 2 Known Good 1439.. microsoftsignedyalid  Microsoft Corpo... Neutral

Equals 06/11/2020 17:05: Known Good 362.7 mi ft,signed,valid Microsoft Corpo...  Neutral
e srarus 06/11/20201 Known Good 6590.. microsoftsignedvalid  MicrosoftCorpo.. Neutral
O Neutral 06/11/20201 Known Good 567KB  microsoftsignedvalid  Microsoft Corpo... Neutral
O Graylist ( 06/11/2020 17:05: Known Good 8026..  microsoft;signedyalid  Microsoft Corpo... Neutral

O Whitelist
06/11/202017:05:.. 2 Known Good 135KB__ microsoft signedyalid,.. Microsoft Corpo... Neutral

You can either save or open the CSV file.

Analyze Certificates

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

The Certificates view provides a list of code-signing certificates reported by hosts found in your
deployment and their associated properties. You can select the certificates under a specific Endpoint
server.

To view the certificates in an Endpoint server:
1. Go to Files.

2. From the drop-down menu, select the Endpoint server to view certificates present on that server. To

view a consolidated list of certificates, select the Endpoint Broker server.

3. Select a file and do one of the following:

RS/\ : Users  Hosts  Files  Da

¥ Filters X | Bendpointloghy.. v

SAVED FILTERS [ FILENAME RISKSCORE ™ FIRSTSEENTIME ONHOSTS REPUTATION SIGNATURE PERESOURCE... FILE STATUS
Select 0 (0) 06/11/202017:0... Known Good microsoft signedyalid  Microsoft Cor...  Neutral

06/11/202017:... Known Good microsoftsignedyalid  Microsoft Cor... Neutral

Change File Status

FILE NAME
Equals Known Good 362.7... microsoftsignedyalid Microsoft Cor...  Neutral

Analyze Events
FILE STATUS Google Lookup

Known Good microsoft signedyalid - Microsoft Cor...  Neutral

[ Neutral 70... Known Good microsoft signedyalid  Microsoft Cor...  Neutral

00 Blacklist VirusTotal Lookup

O Graylist View Certificates 79.. Known Good microsoftsignedyalid ~ Microsoft Cor... Neutral

00 Whitelist
Download File to Server 70.. Known Good microsoft signedyal.. Microsoft Cor...  Neutral

REMEDIATION
D Blocked

Known Good microsoft signedyal..  Microsoft Cor...  Neutral

Known signedyalid VMware, Inc. Neutral
REPUTATION
[ Malicious

Resat Risk Score 70.. Known unsigned = Neutral
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« Right-click and select View Certificates from the context menu.

¢ Click View Certificates in the toolbar.

Change the Certificate Status

You can assign a Whitelist status to the certificate signed by certain trusted vendors and this status can
be automatically applied to all files that is signed by this certificate. If you consider abc a trusted vendor,
you can set the status for the certificates signed by abc as Whitelist.

Similarly, you can also set the certificate status as Blacklist or Neutral. If a company's certificate is
stolen or compromised, you can blacklist this certificate and remediate.

To change the certificate status:

1. Select a certificate, and click Change Certificate Status.

Change Certificate Status

CERTIFICATE 5TATUS

= applied to all files
O Blacklist
O Whitelist
O Neutral

COMMENTS

Enter comments

Cancel

2. In the Change Certificate Status dialog, select a status - Blacklist, Whitelist, or Neutral.

Note: If you have manually updated a file status in the Files or Hosts view, changing the status in
the Certificate view does not impact the file status as the manual update takes precedence. For
example, if you have whitelisted the file vimci.sys that is signed by VMware, Inc. in the Files or
Hosts view, and you have blacklisted VMware, Inc. in the Certificate view, the file vimci.sys
remains Whitelisted though the certificate is blacklisted.

3. Add a comment and click Save.

4. Click < Files to go to the Files view.

Note: In a multi-server environment, changing the status of a certificate in one endpoint server updates
the respective files in other endpoint servers. For example, if a certificate status is set to Blacklist on
one endpoint server, all files signed by this certificate are set to Blacklisted on all endpoint servers.
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Filter Certificates

You can filter certificates on status, signature, friendly name, and thumb print.

“ Filters < Certificates % Change Certificate Status [ Analyze Events -

FRIENDLY NAME STATUS ISSUER THUMB PRINT NOT VALID BEFORE UTCDA1 3

Microsoft Windows Pu_.  Neutral C=U5, 5=Washington, L=Redmaond, $9922da31f07202edb07cd8bs0a. 2018-06-06T18-57:34.000+0000

99922da31f07a02edb07cd8b60a137f144

“ avea Showing 1 out of 1 certificates | 1 selected

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters list. To delete a filter, hover over the name, and click W

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

Resetting Risk Score of Files

You can reset the risk score for a file in these situations:

o Ifthe alerts or events triggered by the host or a file are considered to be false positive, you can make
required changes to the Endpoint Application rules or ESA rules.

« After you take required action on a malicious file.

When you reset the risk score, the risk calculation for the file is deleted and score is set to 0. The risk
score on all the hosts on which this file exists is recalculated. You can reset the risk score for a single
file or multiple files.

To reset the risk score of a file:
1. Go to Files.

2. Select the Endpoint Server or Endpoint Broker.

3. Select one or more files and do one of the following:
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RSA  Investigate  Respon ) Host Dashboards  Reports

Y Filters S endpointloghy... - || View Certificates “® Change File Status || ¢ AnalyzeEvents | v || # More Actions v

S— O ruename RISKSCORE 1 FIRSTSEENTIME  ONHOSTS RePUTATION sizE  sinaTuRE PERESOURCES... FILESTATUS

Select ) 06/11/202017:05:.. 2 Known Good 95MB  microsoftsignedyalid  Microsoft Corpo... Neutral

e 06/11/2020 17:05:.. Known Good 1439.. microsoftsignedyalid  Microsoft Corpo... Neutral

Equals e.g. Filename ) 06/11/2020 17:05: Known Good 3627 ... alid  Microsoft Corpo... Neutral

Known Good 6590..  microsoftsignedyalid  Microsoft Corpo... Neutral

Change File Status
Known Good 56.7KB microsoft,signed,valid Microsoft Corpo... Neutral
Analyze Events

Known Good 8026.. microsoftsignedyalid  Microsoft Corpo... Neutral
Google Lookup < L

VirusTotal Lookup f-05: Known Good 135KB  microsoft.signedalid... Microsoft Corpo... Neutral
BRIl Known Good 7475..  mi edyalid,.. Microsoft Corpo... Neutral
Download File to Server Known signedyalid VMware, Inc. Neutral
Known unsigned - Neutral
Known signedyalid Microsoft Corpo... Neutral

Reset Risk Score i
Known 0...  unsigned VMware, Inc. Neutral
06/11/202017:05:. Known Good microsoftsignedyalid,.. Microsoft Corpo... Neutral

06/11/2020 17:05; Known Good 25...  microsoftsignedyalid,.. Microsoft Corpo... Neutral

06/11/2020 17:05-.. Known Good . microsoftsignedyalid  Microsoft Corpo... Neutral

o
o
o
o
o
o
o
o
o
o
o
o

06/11/2020 17:05... 3 microsoft,signedyalid,.. Microsoft Corpo... Neutral

o Right-click and select Reset Risk Score from the context menu.

o Click More Actions > Reset Risk Score in the toolbar.

All the alerts associated with the score are deleted.

Note: You can select a maximum of 100 files to reset the score.

4. Refresh the page to view and confirm if the file's score is reset. This may take sometime for changes
to take effect.
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Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

The Hosts view allows you to investigate on a host, which includes scan details, tracking events related
to alerts, anomalies, and process details.

Best Practices

The following are some best practices and tips that may help you investigate efficiently to identify and
isolate threats or attacks:

Analyze Events
Analyze Hosts (Navigate or Events g
View)

- Review Risk Contributors

- Perform Adhoc Scan Download Files for
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files Perform Host
Highest Risk Score Forensics

- Search on Snapshot

Change File Status Remediate

- Analyze Processes Perform Extemnal

Lookups

- Review Reported Anomalies
(for Windows)

(Optional) Isolate

- Analyze Risky Users (Users View) Host fi P
ost from Netwo

o Review hosts with highest risk score and analyze the alerts contributing to the risk. Review the
entities, such as file name, processes involved in the alerts. For more information, see Analyze Hosts
Using the Risk Score.

o Review files or processes that created this suspected file, and check if any other files are accessed or
created in the Events view. For more information, see Analyzing Events.

« Review hosts for rare files in the On Hosts column. If a file is present on 100 hosts, it can be
legitimate. If a file is present on fewer hosts with a high risk score, it may be malicious and needs
further investigation.

o Filter to exclude hosts on host status, risk score, hostname, and so on. For more information, see
Filter Hosts.

« Search Google or VirusTotal with the file hash and review any reported activities. For more
information, see Launch an External Lookup for a File.
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« Review the processes, autoruns, files, libraries, drivers, and system information. For example,
o Search for files in known malware locations. For example,
« C:\Windows\.
o C:\Users\<name>\AppData\<uncommon folder>.
o C:\Users\<name>\AppData\Local\Temp.
o C:\Windows\Temp\.

o Search for a particular file name or hash and review the snapshot to check when the file was first
seen.

« Review any network connections established by the process, such as:
o Domain or IP address.

o Ports used (common (80 and 443) versus uncommon ports (8080 , 8888, and 3465)) and check if
the ports are listening actively.

o Check the file compile time. If the date is recent, it could be malicious.
o Check the file creation time on the host.

« Review reported anomalies, such as suspicious threads, kernel hooks, image hooks, and registry
discrepancies. For more information, see Analyze Anomalies.

o Launch Process Analysis to view the sequence of activities performed on the host by the file or
process. For more information, see Analyze Processes.

« Download suspicious files to the server for deeper analysis. For more information, see Analyzing
Downloaded Files.

« Download MFT, process, or system dump to the server for forensic investigation. For more
information, see Performing Host Forensics.

« After investigation if a file is found to be malicious you change the status of the file (blacklist or
graylist) and block infected or malicious file. For more information, see Changing File Status or
Remediate.

o (Optional) If you suspect that a host is potentially compromised with the threat still being active, you
can isolate the host from the network and safely investigate possible threats within the host. For more
information, see Isolating Hosts from Network.

View Hosts

You can view all hosts present on a specific Endpoint server or consolidated list of all hosts on multiple
Endpoint servers using the Endpoint Broker for analysis. By default, hosts are sorted based on the risk
score. To view the hosts:

1. Go to Hosts.
2. Select from the following:
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« Endpoint Broker Server to view all hosts across all Endpoint servers. When querying, the
Endpoint Broker ignores Endpoint servers that are offline. If the Endpoint server is online but is
not responding, the Endpoint Broker waits for 10 seconds, and ignores if it does not respond.

o Endpoint Server to view hosts on a specific Endpoint server.

Hosts

8 endpointbrok...

af

Ubuntu 18.044LTS 05/05/202001:07:05 pm

Red Hat Enterprise Linux 8.1 (Ootpa) 05/06/202007:20:35 am

3. Select a host that you want to analyze.
4. Click a row to view the following details:

o Host Details displays the host information such as Network Interfaces, operating system,
hardware and others.

o Risk Details displays the distinct alerts associated to the risk score and the alerts severity. Click
Critical, High, Medium, or All to display all the alerts. For more information, see Analyzing

Risky Users.
Click Show next 100 hosts to view other hosts.

6. Click the host name to investigate the scan results. For more information, see Analyze Host Details.

View Agent History

You can view the list of commands issued to the agents (by the server or actions performed by any
analyst) in the Host view and Host details. By default, commands are sorted based on the command
time.

To view the commands:
1. Go to Hosts.

2. Do any one of the following,

e To view all commands, click . You can also filter commands, for more information see Filter
Hosts.

8 endpointbrok... E\é

[0 HOSTNAME RISKS.. AGENTLAST.. AGENTSCANST.. AGENTGROU.. AGENTMODE  AGENT VERSION  AGENT-D.. AGENT - INSTALLTIL. AGENT ID LASTSCANTI 5}

The Agent History view is displayed. For more details, see Analyze History.
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o To view commands specific to a particular host:
o Click the host for which you want to view the commands.

o Inthe Host details view, click History tab. You can also filter commands, for more information
see Filter Host Details.
The History view is displayed. For more details, see Analyze History.

o Hosts [l Dashboar

(] AGENT SCAN STATUS AGENT LAST SEEN AGEN
Scanning 2daysago 115

AUTORUNS ~ FILES ~ DRIVERS  LIBRARIES ~ ANOMALIE ) ADS  SYSTEM INFO

History

@) custompate | COMMAND TIME £ COMMAND TYPE HOST NAME USER NAME STATUS COMMAND PARAMETER PROCESSED TIME LAST RETRIEVAL TIME

06/15/2020 08:06:29 am Download File system 06/15/2020 08:06:35 am

02007:18:47 a

06/08/202007:18:47 am

Contains

system

v
v
v
v
v
v
v
v
v
v
v
v

system

Filter Hosts

You can filter hosts on agent version, agent ID, agent mode, agent last seen, last scan time, operating
system, hostname, username, Mac address, risk score, [IPV4, driver error code, security configurations,
agent groups, and host status - managed, roaming, and isolated.

In the Host view > click , to filter the commands on command type, status, host name, request type,
command parameter and command time. In the Command Time field, you can filter by custom date
range.

Note: While filtering on a large amount of data, use at least one indexed field with the Equals
operator for better performance. The following fields are indexed in the database - Hostname, IPv4,
Operating System, Last Scan Time, and Risk Score.
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Hosts Fil

O HOSTNAME RISK SCORE  OS5-DESCRIPTION LAST SCAN TIME
b Microsoft Windows 10 Pro for Workstati... 05/08/2020 02:21:35 pm
N Red Hat Enterprise Linux- 7.2 05/05/2020 05:59:16 pm
Red Hat Enterprise Linux- 7.2 05/06/2020 07:38:30 am
Microsoft Windows 8.1 Enterprise 05/06/2020 07:47:47 am
Ubuntu 18.04.4LTS 05/05/2020 01:07:05 pm
Red Hat Enterprise Linux 8.1 (Ootpa) 05/06/2020 07:20:35 am
Microsoft Windows 10 Education
Microsoft Windows 7 Enterprise
HOSTNAME Microsoft Windows 10 Enterprise
Equals

Ubuntu 16.04.6 LTS 05/07/2020 08:44:18 am

USERNAME { CentOS Linux 8 (Core) 05/06/2020 07:32:31 am

Equals Microsoft Windows 10 Education

AGENT G s Microsoft Windows 7 Enterprise 05/08/202006:53:58 am

Equals

NIC C ADDRESS

Equals

Showing 13 out of 13 hc | 0selected

To search multiple values within a field, set the filter option to Equals, and use | | as a separator.

For example, using Equals operator for multiple IPV4 values with a separator |
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Y Filters

USERNAME

Equals v Enter value

AGENT GROUPS

Equals v Enter value

NIC MAC ADDRESS

Equals v e.g.00:00:00:00:00:

IPV4

Equals v 10.87.225.68] |10.40.7.11

AGENT LAST SEEN

LAST SCAN TIME . CUSTOM DATE

OPERATING SYSTEM

O Windows
O Linux
O Mac

AGENT MO

To filter on the agent last seen or last scan time, select the option from the drop-down list. If you select 3
Hours ago for the Last Scan Time, the result displays hosts that were last scanned 3 hours ago or earlier.

To filter on the risk score, use the slider to increase or decrease the values between 0 to 100.
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Y Filters

RISK SCORE

HOSTNAME

Equals v Enter value

USERNAME

Equals v Enter value

AGENT GROUPS

Equals v Enter value

NIC MAC ADDRESS

Equals .£.,00:00:00:00:00:00

IPV4

Equals v ooeg, 1.1.1.1]]1.1.1.1

AGENT LAST SEEN

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added
to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click [}

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

You can also filter the commands on command type, status, host name, request type, command

parameter and command time (In which you can filter by custom date range), by clicking =®
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Adding and Sorting Columns in the Table

By default, the Hosts view displays a few columns and the hosts are sorted based on the risk score. To
add or remove columns:

1. Go to Hosts.

2. Select the columns by clicking £3 in the right-hand corner.

Type to filter

Hostname

Agent Scan Status

Agent Groups

1P

Policy Status

Agent Mode

Last Scan Time
Username

Agent Versio

Agent- Driver Error Code

Operatin

3. Scroll down or enter the keyword to search for the column.

4. Click the arrow on the column header to sort the column in ascending or descending order.

Scan Hosts

You may want to perform an on-demand scan if you want to get the latest snapshot of the host.

When the hosts are scanned, the Endpoint Agent retrieves the following data that can be used for
investigation:

« Drivers, processes, DLLs, files (executables), services, autoruns, anomalies, host file entries, and
scheduled tasks running on the host.

« System information such as network share, installed Windows patches, Windows tasks, logged-in
users, bash history, and security products installed.

Investigating Hosts
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To start a scan:
1. Go to Hosts.
2. Select one or more hosts (up to 100) at a time for an on-demand scan, and do one of the following:

o Right-click and select Start Scan from the context menu.
o Click Start Scan in the dialog.

Note: (Version 11.5.1) By default, the scan utilizes 25% of the CPU. You can click CPU
Maximum and select a value between 5% and 100%. A lower CPU Maximum value increases
the scan time but allows other processes to utilize the CPU. Increasing the CPU Maximum limit
reduces the scan time but may result in more CPU usage.

3. Click Start Scan in the dialog. This performs a quick scan of all executable modules loaded in
memory.

The following are the scan statuses:

s Jomsrpren

Idle No scan is in progress.
Scanning Scan is in progress.

Pending  Scan request is sent to the server and the agent will receive the request the next time it
communicates with the server.

Cancel  Stop request is sent to the server and the agent will receive the request the next time it
communicates with the server.

Analyze Hosts Using the Risk Score

You can investigate a host by analyzing the risk contributors such as alerts and events to look for
suspicious or malicious activity.

To analyze the hosts using the risk score:
1. Go to Hosts.

The Hosts view is displayed.

2. Inthe Server drop-down list, select the Endpoint server or Endpoint Broker server to view the hosts.

3. Select the host and do any of the following.
o Click a row to view the risk associated with the host in the Risk Details panel.
« Click the hostname to investigate the host.
4. Inthe Alert Severity panel, click the alert severity such as Critical, High, Medium, or All.
The list of distinct alerts is displayed along with the total number of events associated with the alert.

5. Click an alert to view the associated events.
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ALERTS SEVERITY

2 10 &

18 events

25

EVENT TIME
03/01/2019
02:34:08.000
Enables Cleartext Credential Storage (1) pm
1 event(s)

CRITICAL HIGH

) meotum A

FILE NAME

SOURCE  malware10.exe

Enables Login Bypass (18)

18 event(s) TARGET  REG.exe

EVENT TIME
03/01/2019
02:34:08.000
pm

FILENAME

SOURCE  malware0.exe

TARGET  REG.exe

EVENTTYPE CATEGORY
Endpoint Process Event createProcess

EVENTTYPE CATEGORY
Endpoint Process Event createProcess

@ Events rolled over due to retention policies or manual deletion will not be available.

HOSTNAME

LAUNCH ARGUMENT
malware10.exe -dil:ioc.dll -testcase:400,401

REG.exe ADD *HKLI\SOFTWARE Wi
rentVersion\Image File Execution

S\displayswitchche” /v Debugg:r/l REG SZ/d

dows\system32\cmd. exe®

HOSTNAME

LAUNCH ARGUMENT

malware10.exe -dll:ioc.dll -testcase:400,401

REG.exe ADD *HKLM\SOFTWARE WicrosoftWWindows

G
tons\utiman,exe’ /ngebuggerll REG_SZ/d

USER ACCOUNT

oft\Windows

USER ACCOUNT

OPERATING SYSTEM HASH
windows Oedagl

CAUsers\ecat\Desktop\

CWindows\system32\

OPERATING SYSTEM HASH
windows Oedasl

CAUsers\ecat\Desktop\

C:AWindows\system32\

"C:\windows\system32\cmd.exe’

EVENT TIME
03/01/2019
02:34:08.000
pm

EVENTTYPE CATEGORY
Endpoint Process Event createProcess

ACTION HOSTNAME

USER ACCOUNT

OPERATING SYSTEM HASH
windows Oeda8l

HOST DETAILS

T Iter list

POLICY DETAILS

Show details with values only

D
dmin

2
true

Administrators

Intel(R) PRO/1000 MT Networ...

10.40.7.16

Note: Only the latest 1000 events are displayed.

6. To view all the metadata associated with a specific event, click the event header. The
such as source path, target path, filename, and others is displayed.

@ Events rolled over due to retention policies or manual deletion will not be available.

18 events
2 1 13

§ meoum f—

03/0172019
02:34:08.000 pm

GO e Endpoint Process Event
Enables Cleartext Credential Storage (1)

SOURCE

PATH
Enables Login Bypass (18) CAUsers\ecat\Desktop\
18 events) FILE SHA256
Qedasba34ddcaes0sceacebashca3ifo29dedbe
0992a1eb31130b794134c55dl
FILENAME
malware10.exe

LAUNCH ARGUMENT
malware10.exe -dll:ioc.dll testcase:400,401

DEVICE

USERNAME
WIN-NMUFVI3DGTN\ecat
HAsH

Oeda8ba34ddca6909c66cebasbc231f029dedbe
0992a1eb31130b794134c55db

RELATED LINKS

createProcess

TARGET
PATH
Cawindows\system32\

FILE SHA256
19316d4266d0b77609b2a05d5903dBcbcs0ea
1520e9c2a7e6d5960b6faddcaf

FILENAME
REG.exe

LAUNCH ARGUMENT
REG.exe ADD
"HKLM\SOFTWAREMicrosoftWindows
Mcurrentversion\image %
Options\displayswitch. Debugger
R doweysterma i ener

DEVICE
HASH

193160426600b776d9b2a0505903d8cbc8f0ea
1520e9c2a7e6d5960b6faddcat

information

windows Oeda8ba34ddca6909c66cebasbc231f029dedbc0992a1eb31130b794134cs5db.

DOMAIN/HOST
size

r

DATA

FiLENAME

malware10.exe

size

@

HasH
0Oeda8ba34ddca6909c66cebasbc231029d
edbc0992a1eb31130b794134c55dD
AGENT ID
93B4DD24-9103-9792F985-FE6141338C91
DEVICE TYPE

nwendpoint

EVENT SOURCE
10.40.14.52:50005

USER SRC
ALIAS IP
EVENT SOURCE ID

118794
USER

7. Hover over one of the meta values for IP, Hostname, Mac, File name, File hash, User, and Domain
to view additional information about the specific metadata. A hover box displays a list of the data
sources that have context data available for meta value. These are the possible data sources:
NetWitness Endpoint, Incidents, Alerts, Hosts, Files, Feeds, and Live Connect.

CONTEXT HIGHLIGHTS
0 0

ACTIONS

Add/Remove from List
INCIDENTS Al ERTS

Q, Pivot to Investigate > Mavigate

Q, Pivot to Investigate > Hosts/Files
Q, Pivot to Endpoint Thick Client

ENDPOINT CRITICALITY ASSET RISK

View Context

ACTION
createProcess

HOSTNAME USER ACCOUNT

8. To investigate the original event and destination domain of the event, do any of the following:
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ALERTS SEVERITY

2 10 13 25

| veium .

CRITICAL HIGH
Enables Cleartext Credential Storage (1)
1 eventls)

Enables Login Bypass (18)
18 eventls)

@ Events rolled over due to retention policies or manual deletion will not be available.

18 events

EVENT TIME
03/01/2019
02:34:08.000 pm

EVENT TYPE CATEGORY
Endpoint Process Event

SOURCE

PATH

C:\Users\»#\Desktopy

FILE SHA256
Oeda8ba34ddc46909c66cebasbc231f029dedbe
0992a1eb31130b794134c55db

FILENAME
malware10.exe

LAUNCH ARGUMENT
malware10.exe -dll:ioc.dll -testcase:400,401

DEVICE

USER
USERNAME

HASH
Oeda8ba34ddc46909c66ceba: 5h(23'\ fo29dedbc

createProcess

HOSTNAME USER ACCOUNT

TARGET
PATH
Cwindows\system32\

FILE SHA256

19316d4266d0b776d9b2a05d5903d8cbc8f0ea
1520e9c2a7e6d5960b6faddcaf

FILENAME
REG.exe

LAUNCH AREUM ENT

REG.©

HKLM\SOFFWARE\MI(rnEOﬂ\W’ndDWS
NT\CurrentVersion\image File Execution
Dptluns\dls I itch.exe” /v Debugger /t
REG_SZ /d "C: \wmdows\systemSZ\:md exe" /f

DEVICE

HASH
19316d4266d0b776d9b2a05d5903d8cbc8f0ea

OPERATING SYSTEM
windows

DOMAIN/HOST

SIZE

2

DATA

FILENAME

malware10.exe

size

a4

HASH

0Oedagba34ddc46909ce6ce! bashc231ﬂ)29d
edbc0992a1eh31130b794134c55d|
AGENTID
93B4DD24-9103-9792-F985-FE6141338C91

DEVICE TYPE
nwendpoint

0992a1€b31130b794134c55db. 1520e9c2a7e6d5960b6fa4dcaf

RELATED LINKS

« To reconstruct an event in a readable form that matches the original, click the Investigate
Original Event link highlighted in blue. For more information on event reconstruction, see the
NetWitness Investigate User Guide.

« For details about the elements associated with an event, click the Investigate Destination
Domain link highlighted in blue. For more information on Contextual Information for an Event, see
the NetWitness Investigate User Guide.

Note: Investigate Destination Domain link is not displayed if there is no domain.dst event.

« To view a list of processes captured on the hosts and investigate a particular process, click the
Analyze Process link highlighted in blue. For more information on process analysis, see
Investigating a Process.

Note: Analyze Process link is not displayed if there is no createprocess event.

Analyze Host Details

To look for suspicious files on a host, click the host name and view the details of the host, or start an on-
demand scan to get the most recent information. On the right-hand panel, you can view the following:

o Host Details displays the host information, such as Network interface, operating system, hardware
and others.

o Policy Details displays the complete resolved policy settings.

For more details, see Hosts View - Details Tab.
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RSA | e X d Users Hosts Files BE! Reports

100 = AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

SNAPS 06/24/2020 21:30:33
e afew seconds ago 11500 snapsHoTTIME  06/24/202021:30:33

windows

DETAILS  PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ANOMALIES DOWNLOADS  SYSTEM = P20

ALERTS SEVERITY ® Events rolled over due to retention policies or manual deletion will not be :
28 events HOST DETAILS

CRITICAL

EVENTTIME EVENTTYPE  CATEGORY  ACTION HOST

06/29/2020 13:40:54.000 Endpoint File

FILENAME HASH Show details with values only

Blacklisted File (28) e5b7957f01540c1e3eadfb4bO... N

Groups

28 event(s) ;
FILENAME LAUNCH ARGUMENT Groups  Windows-security

Runs Blacklisted File (3) SOURCE

3event(s) TARGET

EVENT TIME EVENT TYPE CATEGORY ACTION HOST
06/29/2020 13:40:54.000 Endpoint File

2
FILENAME HASH
intl.dll 639ff2ef6hchaad1796b83706... s Administrators

FILE NAME LAUNCH ARGUMENT

SOURCE
TARGET

Filter Host Details

In the Processes, Autoruns, Files, Drivers, Libraries, and Anomalies tabs, you can filter the processes or
files on file status, reputation, file or process name, signature, and risk score. Click Save to save the
filter and provide a name (up to 250 alphanumeric characters). The filter is added to the Saved Filters

panel on the left. To delete a filter, hover over the filter name and click .

In the Host view > Files tab, you can filter the files available on host, and files deleted from host. The
result of files deleted from host depends on the data retention policy configured in the Endpoint Config
view > Data Retention Scheduler tab. By default, data retention policy is configured for 30 days, this
means only 30 days of deleted files are stored in the Endpoint server. These filter options are disabled if
All Files Available on Host toggle is disabled.

In the Host view > History tab, you can filter the commands on command type, status, host name,
request type, command parameter and command time. In the Command Time field, you can filter by
custom date range.

Click Save to save the filter and provide a name (up to 250 alphanumeric characters).The filter is added
to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click 11}

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

Search Files on Host

To investigate a host or to check if it is infected with a known malware, you can search for occurrences
of the file name, file path, or SHA-256 checksum.

Note: To search for a SHA-256 checksum, provide the entire hash string in the search box.

The result displays the matching files present on the host in All Files Available on Host category and in
the respective snapshot category with the details, such as file name, signature information,and
checksum. In addition, the snapshot category displays the system interaction, for example, ran as
process, library, autorun, service, task, or driver. To view more details, click the filename or system
interaction link.
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Example, a user has clicked and executed a malicious attachment through a phishing email, and
downloaded it to C: \Users. To investigate this file:

1. Goto Hosts.

2. Select the host that you want to investigate or select the Endpoint Broker server to investigate all the
hosts.

3. In the Details tab, enter the file path C:\Users in the search box.

The search displays a maximum of 100 results of the executables in this folder. In this example, the
file Malware.exe, is an unsigned file that might be malicious. If the search is executed on an
Endpoint Broker server, it queries all the Endpoint servers.

100 [E -~ AT ST VERSIO sNAPSHOT TIME  11/18/201909:28:10am

DETAILS PROCE. S AUTORUNS FILES

ALERTS SEVERITY

EVENT TIME

EVENTTYPE A ‘
CRITICAL £l 11/18/2019 09:31:17.000 am Endpoint Autorun

@ Events rolled over due to retention policies or manual deletion will not be
12 events

FILE NAME A
55 Configured (12) % 79d2.

EV PE v
Endpoint Autorun

FILENAME

This file is run as a Process.

4. To view details of this file, click Process in the result.

TiMe  11/18/201909:28:10am

MALWARE.EXE
DETAILS PRO S AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES D QADS SYSTEM

ALERTS SEVERITY @ Events rolled over due to retention policies or manual deletion will not be ¢
EVENT TIME

CRITICAL oL 11/18/2019 09:31:17.000 am

12 events

in B Configured (12)

EV PE ‘
Endpoint Autorun

79d2:

This opens the Process tab where you can view the process details.
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Analyze Processes

To analyze the process:

1. Inthe Hosts details, select the Processes tab.

RSA

AGENT S¢ aTus AGENT LAST SEEN AGENT VERSION

Idle afew seconds ago 11 suarsiot TR 06/24720

windows

(mALWARE EXE |

DETAILS  PROCE AUTORUNS  FILES S LIBRARIES ANOMALIES  DOWNLOADS MINFO  HISTORY

Y Filters X | Proc @ ) TReEviEW

[0 PROCESS NAME LOCAL RISK SCORE GLOBAL RISK SCORE ON HOSTS REPUTATION FILE STATUS DOWNLOADED FILE PATH
100 100 2 Known Good Blacklisted - C:AWindows\System3;
2 Known Good Blacklisted - CAWindows\System3:
2 Known Good Neutral - CAWindows\System3:
Known Good Neutral C:AWindows\System3:
Known Good Neutral - C:\Windows\System3:
Known Good Neutral - CAWindows\System3:
Known Good Neutral - CAWindows\System3:

Known Good Neutral - C:AWindows\System3:

m]

o 100
u} 100
o 100
u} 100
o 100
o 100
o 100
u} 100

Known Good Neutral - C:\Windows\System3:

100 E

windows

afewseconds ago 11400 11/18/2019 09:28:10 am

MALWARE EX

DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY

Y Filters Processes

[] PROCESS NAME LOCAL RISK SCORE GLOBAL RISK SCORE ON HOSTS REPUTATION

o o 1

o o 1

OO0 0 D0 O0O|O0|0|0O

2. In the Processes Tab, do one of the following:
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o Click a row to view the properties of a process in the right panel.

Hosts File

e — 11400 11/18/2019 09:28:10 am

MALWARE_EXE
DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY
¥ Filters Processes @ Analyze Process % Change File Status @ Analyze Events | v $ More v @) Treeview

FILE DETAILS
[) PRoCESs NAME LOCALRISKSCORE  GLOBALRISKSCORE  ON HOSTS REPUTATION FILE STATUS SIGNATURE DOWNLOADED

[
6.962615335730437
897.0KB

pe

microsoft signedvalid,catalog
11/20/2010 07-35:27.000 pm
02eceea9dS5e0a9f3e39b6f4ecat.

Microsoft Windows

R SA = Hosts Files

1m AGENT SCAN STATUS AGENT LAST SEEN

SNAPSHOT TIME  06/24/202021:30:33
Idle afew seconds ago

windows

DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY

< Processes | Process Details

indows\System32\

When reviewing processes, it is important to see the launch arguments. Even legitimate files can be used
for malicious purposes, so it is important to view all of them to determine if there is any malicious
activity.

For example,

e rundll32.exe is a legitimate Windows executable that is categorized as a good file. However, an
adversary may use this executable to load a malicious DLL. Therefore, when viewing processes, you
must view the arguments of the rund1132.exe file.

e LSASS.EXE is a child to WININIT.EXE. It should not have child processes. Often malware use this

executable to dump passwords or mimic to hide on a system (lass.exe, 1ssass.exe,
lsasss.exe, and so on).
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« Most legitimate user applications like Adobe and Web browsers do not spawn child processes like
cmd. exe. If you encounter this, investigate the processes.

You can view the sequence of activities performed on the host by the file or process using the process
analysis. For more information, see Investigating a Process.

Analyze Autoruns

In the Hosts details, select the Autoruns tab. You can view the autoruns, services, tasks, and cron jobs
that are running for the selected host.

For example, in the Services tab, you can look for the file creation time. The compile time is found
within each portable executable (PE) file in the PE header. The time stamp is rarely tampered with, even
though an adversary can easily change it before deploying to a victim's endpoint. This time stamp can
indicate if a new file is introduced. You can compare the time stamp of the file against the created time
on the system to find the difference. If a file was compiled a few days ago, but the time stamp of this file
on the system shows that it was created a few years ago, it indicates that the file is tampered.

Analyze Files

To analyze the files, you can do either one of the following based on your requirement.

o In the Hosts view, select the Files tab.
You can view the list of all files (reported as part of scan and tracking) on the host including the
deleted files.

Hosts

AGENT SCAN STATUS AGENT LAST SEEN

AGENT VERSION
o I 11500 sNapsHOT TIME  06/20/2020 06:30:11 am

DETAILS  PROCESSES S FILES  DRIVERS  LIBRARIES ~ ANOMALIES ~ DOWNLOADS  SYSTEM INFO  HISTORY

Y Filters X | Files

@ ALL FILES AVAILABLE ON HOST

e FILENAME LOCAL RISK SCORE GLOBALRISK SCORE  ON HOSTS FILE STATUS REPUTATION DOWNLOADED PATH

Equals Neutral Known Good
P Neutral Known Good
O Neutral Neutral Known Good - C:\Windows\SysWOW64\
Neutral Known Good - C:\Windows\Microsoft.NET\asser

Neutral Known Good

Neutral Known Good

o
o
o
o
o
o
o
o

Neutral Known Good

Neutral Known Good

Neutral Known Good

Neutral Known Good

Neutral Known Good

o To view the files reported as part of scan snapshot, you must disable All Files Available On Host
toggle and select the scan time form the Snapshot drop-down list.

Example for analyze files, many trojans write random filenames when dropping their payloads to prevent
an easy search across the endpoints in the network based on the filename. If a file is named
svchOst.exe, sevhost.exe, or svchosts.exe, it indicates that the legitimate Windows file named
svchost.exe is being mimicked.
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Analyze Libraries
In the Hosts details, select the Libraries tab. You can view the list of libraries loaded at the time of
scan.

For example, a file with high entropy gets flagged as packed. A packed file means that it is compressed
to reduce its size (or to obfuscate malicious strings and configuration information).

Analyze Drivers

In the Hosts details, select the Drivers tab. You can view the list of drivers running on the host at the
time of scan.

For example, using this panel, you can check if the file is signed or unsigned. A file that is signed by a
trusted vendor such as Microsoft and Apple, with the term valid, indicates that it is a good file.

Analyze Anomalies

Note: This tab is available only for advanced agent.

In the Hosts details, select the Anomalies tab. You can view the following details for the selected host:

o Image hooks - Hooks found in executable images (user-mode or kernel-mode) - IAT, EAT, Inline,
exceptionHandler.

« Kernel hooks - Hooks found on kernel objects (such as Driver Object [Pointers, IRP_MJ, SSDT, IDT,
and so on]). This also includes filter devices.

o Suspicious threads - Threads whose starting address points to memory DLLs or floating code. The
threads could be running with either user-mode or kernel-mode privileges. These threads could run
malicious code inside a trusted application to execute their own code.

o Registry discrepancies - The Windows registry is a hierarchical database that stores configuration
settings and options on Microsoft Windows operating systems. It contains settings for low-level
operating system components and for applications running on the platform: the kernel, device drivers,
services, SAM, user interface, and third party applications all use the registry. The discrepancies
between low-level parsing with Win32 registry API are reported.

Note: Anomalies is applicable only for Windows hosts.

For example, hooking is used to intercept calls in a running application and to capture information related
to the API invocations. Malicious programs can implant hooks in various system applications for
different purposes, such as hiding files, directories, registry entries, intercepting users keystrokes to
establish a stealthy communication channel with the attacker.

Analyze System Information

In the Hosts details, select the System Information tab. This panel lists the agent system information.
For Windows operating system, the panel displays the host file entries and network shares of that host.

For example, malware might use host file entries to block antivirus updates.
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Analyze History

In the Host details, select the History tab. This tab lists the commands along with the respective status
and additional details.

When you review the history, look for the command status and retrieval count to check if the agent
retrieved the commands.

Below are some examples:

o A file download command is issued, but the file is deleted on the host. In this case status of the
command is failed as the file is not downloaded.

o The retrieval count increases, but the command is not processed. This happens when an analyst
requests a large number of files (For example, MFT, system dump, or process dump), and the
connection breaks when the agent uploads these files.

« If the agent command is not retrieved, the agent is either offline or busy processing other commands
(For example, uploading a system dump). In this case, the status of the command shows pending.

To view more details, click the Hostname link highlighted in blue. The Hosts details view is displayed.
In the case of MFT, download file, system dump, and process dump command types, Downloads tab is
displayed with details such as file name, type, status, size, downloaded time and SHA256 of the file,
when you click on the Hostname link.

Export Host Details or Files to JSON File

Note: Export Host details option is disabled if there is no snapshot time.

To export host details or files to JSON file:
1. Go to Hosts.

2. Select the hostname to open the host details.

3. Click i (More) beside the hostname and do any of the following:

o To export the scan data categories for the host, select Export Host Details. This exports files
such as:

o allfiles.json - This file consists of the file name, file path, signature, file checksum, and so on
that is reported as part of scan and tracking.

o fileContext.json - This file consists of the file name, file path, signature, file checksum, and so
on that is reported during the host scan.

o machinedetails.json - This file consists of the machine details, including hardware, operating
system, interfaces, and so on, along with the agent details like version, policy details.

Note: If Endpoint Broker is selected and a host is communicated with multiple Endpoint servers,
during the host details export, all files and details of the host are exported from the Endpoint server
where the selected snapshot is stored.
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Note: allfiles.json file is exported irrespective of the selected snapshot.

o To export all the files available on the host, select Export Files. This exports:

o allfiles.json - This file consists of the file name, file path, signature, file checksum, and so on
that is reported as part of scan and tracking.

Launch an External Lookup for a File

While analyzing a file, you can search Google or VirusTotal with the filename or hash to get more
information about the file. To launch the search:

1. Go to Hosts > Host Details (Autorun, Files, Drivers, Libraries, or Anomalies tab).

2. Right-click one or more files, or in the More Actions drop-down list in the toolbar, do the following:

RSA Investig Hosts ~ Files T

100 : AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

swapstior TiMe O] 30
Idle afewsecondsago 11500 FATSHOTTINE W

windows

DETAILS ~ PROCESSES ~ AUTORUNS ~ FILES ~ DRIVERS  LIBRARIES ~ ANOMALIES ~ DOWNLOADS ~ SYSTEMINFO  HISTORY

Y Filters X Processes @) mecview

PROCE [ PROCESS NAME LOCALRISKSCORE  GLOBALRISKSCORE  ONHOSTS REPUTATION FILESTATUS  DOWNLOADED FILE PATH
Equals -
4 n| 2 Known Good Blacklisted C\Windows\System3|
FILE STATUS = Known Good Blackisted - C:\Windows\System3

0 Neutral R
o Known Good Neutral - C\Windows\System3
0 Blacklist Change File Status

O Graylist — Known Geod Neutral - CAWindows\System3
0 Wil v

Google Lookup Known Good Neutral . C\Windows\System3
REPUTATION
. ViusTotal Lookup Known Gaod Neutral . C:\Windows\System3
0 Malicious
0 Suspicious Download Process Dump o Server Koown Good Netral - CWindows\ysten
0 Unknown
0 Known Download File to Server Known Good Neutral - C:\Windows\System3
0 Known Good

. Known Good Neutral - C:\Windows\System3
O Invalid

Known Geod Neutral - C2\Windows\System3

Known Geod Neutral - C\Windows\System3

o Select Google Lookup to perform a search on the filename, MDS5, SHAT1, or SHA256.
o Select VirusTotal Lookup to perform a search on MD5, SHAT1, or SHA256.

Note: To open files in multiple tabs, make sure you enable the pops-up in the browser.
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Delete a Host

If the agent is uninstalled on a host or if you no longer require the host scan data, you can manually
delete this host from the Hosts view. Deleting a host deletes all scan data associated with the host. To

delete hosts:
1. Go to Hosts.

2. Select the hosts that you want to delete from the Hosts view and do one of the following:

RSA
Y Filters

SAVED FILTERS

Select
HO

0 Roaming

O Isolated

RISK SCORE

0

HOSTNAME

Equals

Files

X © endpointbrok... v [ Analyze Events @ Start Scan

[0 HOSTNAME

0

RISK SCO.J  OS - DESCRIPTION LAST SCAN TIME USERNAME
100 Microsoft Windows 10...  06/28/202021:30:08 WINDWOS...

:30:33  WINDOWS...
Analyze Events

Delete

Start Scan

Network Isolation

Download MFT to Server

Download System Dump to Server

Download Files to Server

Reset Risk Score

o Right-click and select Delete from the context menu.

o Click More drop-down list in the toolbar and select Delete.

admin >

AGENT LASTSEEN ~ AGENTSCANSTA.. AGEN {5}
afewsecondsago  Scanning
afewsecondsago  Idie

afewsecondsago  Idie

Note: If you accidentally delete a host from the Hosts view, the Endpoint Server forbids all requests
from this agent. The agent must be uninstalled manually from the host and reinstalled for it to appear
on the Hosts view.

Deleting Hosts with Older Agent Versions

After upgrading the 11.1.x and 11.2.x agents to 11.3 or later, if you want to delete the hosts with older

versions:

1. Go to Hosts view.

2. Filter the hosts based on the Agent version, and delete these hosts.

If you do not delete, the hosts are deleted based on the Data Retention Policy settings.
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Set Hosts Preference

By default, the Hosts view displays a few columns and the hosts are sorted based on the risk score. If
you want to view specific columns and sort data on a specific field:

1. Go to Hosts.

2. Select the columns by clicking =3 in the right-hand corner. The following example shows the drop-
down list displayed while adding columns:

Hostname

Risk Score

Username

Agent Version

3. Scroll down or enter the keyword to search for the column in the displayed list.

4. Sort the data on the required column.

Note: The selections you make here become your default view every time you log in to the Hosts
view.

Export Host Attributes

You can export up to 100,000 host attributes at a time. To extract the host attributes to a csv file:
1. Go to Hosts.

2. Filter the hosts by selecting the required filter options.

3. Add columns by clicking Ed in the right-hand corner.
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4. Click to export the host attributes to a csv file.
RSA  inestizste

Y Filters S endpointbrok...

HOSTNAME RISKSCORE < LAST SCAN TIME USERNAME
NA Stati.. 05/08/202002:21:35pm Wi 8e\DWM-2WIN1909-64B-O\e... a
R 05/05/202005:59:16 pm root

05/06/202007:38:30 am root

05/05/202001:07:05pm  kslp

05/06/202007:20:35 am kslp

u}
u]
o
o
u] cr nterprise 05/06/202007:47:47 am WINB1X64-1\AdministratorWindow Manager...  a
u}
u}
u]
o

You can either save or open the csv file.

Migrate Hosts

Hosts can be migrated from one Endpoint server to another using groups and policy associated with the
host. If a host is migrated, the Server column shows as Migrated. On all the tabs within the Hosts view,
the message Host is migrated to <Server-name> is displayed. You view the host details by clicking the
<Server-name>. The risk score of a migrated host is displayed on all Endpoint servers where it is
present.

Note: Some of the actions are disabled for the migrated host on the selected server, such as start scan,
start stop, analyze events, and others. If you want to perform the required action, select the Endpoint
server to which the host is migrated.

Note: To view only managed hosts, select the Show Only Managed Agents option in the Filters
panel.

Analyzing Risky Users

If you have NetWitness UEBA installed, you can view the alerts associated with users logged in on the
host. To analyze risky users:

1. Go to Hosts.
2. Click the host name you want to analyze.

3. In the Host Details panel, under the Users category, click the name.
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This opens the Entities tab for investigation in a new tab.

RSA

5% Winqwoﬂo,o g s o AGENT LaST seEN

e 1500 swapstor Tive  06/25/2020 21:30:30

DETAILS PROCESSES ~ AUTORUNS FILES DRIVERS LIBRARIES ~ ANOMALIES DOWNLOADS  SYSTEM INFO HISTORY
ALERTS SEVERITY © Events rolled over due to retention policies or manual deletion will not be available.

70events HOST DETAILS
EVENT TYPE RY  ACTION € USERACCOUNT  OPERATINGSYSTEM

EvenT TIvE v
EREL A 06/25/2020 14:01:27.000  Endpoint )¢ windows

Show details with values only

FILENAME A

Blacklisted File (70)
70 event(s)
Windows-security

EVENTTIM EVENTTYPE  CATEGORY CTION  HC " JSER ACCOUN OPERATING SYSTEN
06/25/2020 14:01:26.000 Endpoit windows
D 2
Administrators

EVENTTYPE ORY  ACTION  HOSTNAME JSER ACCOUN OPERATINGSYSTEM

EVENTTIME
06/25/2020 14:01:26.000 Endpoint Windwos10-Q windows

HasH
36R96070f29:86b6d8ac 604

FILENAME

Resetting Risk Score of Hosts

You can reset the risk score for a host in these situations:

« Ifthe alerts or events triggered by the host or files on the host are false positive, you can make
changes to the Endpoint Application rules or ESA rules.

« After you take required action on the host for malicious file activities contributing to the risk score.
When you reset the risk score, all the risk calculation for the host is deleted. When you reset the
host's risk score, it does not change the file's risk score. You can reset the score for a single host or
multiple hosts.

To reset the risk score of a host:
1. Go to Hosts.

2. Select the Endpoint Server or Endpoint Broker.

3. Select one or more hosts and do one of the following:
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8 endpointbrok... ™

O HOSTNAME RISK SCORE

O N/A

N/A

N/A

Delete

Start Scan

Reset Risk Score

@ Start Scan

4+ OS5 - DESCRIPTION
Microsoft Windows 10 Pro for Workstati...
Red Hat Enterprise Linux- 7.2
Red Hat Enterprise Linux- 7.2
Microsoft Windows 8.1 Enterprise
Ubuntu 18.04.4 LTS
Red Hat Enterprise Linux 8.1 (Ootpa)
Microsoft Windows 10 Education

Microsoft Windows 7 Enterprise

« Right-click and select Reset Risk Score from the context menu.

¢ Click More Actions > Reset Risk Score in the toolbar.

All the alerts associated with the score are deleted.

LAST SCAN TIME

05/08/2020 02:21:35 pm

05/05/2020 05:59:16 pm

05/06/2020 07:38:30 am

05/06/2020 07:47:47 am

05/05/2020 01:07:05 pm

05/06/2020 07:20:35 am

Note: You can select a maximum of 100 hosts to reset the score.

4. Refresh the page to view and confirm if the host's score is reset. This may take sometime for

changes to take effect.
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Investigating a Process

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

Analysts can perform process analysis to investigate a particular process behavior to:

o Understand the entire process event chain, process parent-child relationships, and all associated
events in a timeline view.

« Analyze important process attributes, such as username, launch arguments, reputation, file status,
signer, signature, risk score, and file path.

The Analyze Process view provides a list of processes captured on hosts in a parent-child hierarchical
format over a time range. The process tree is created from the tracking event type "Process event"
where the action meta key is createProcess. The agent reports new events for the same
createProcess if the following parameters change:

« Parent process filename
« Child process filename
o Launch arguments

e User name

If the above parameters do not change, the event is reported only once every eight hours.

Best Practices

When reviewing a host for malicious activity, there are a few key things to review while looking for
malicious processes.

o Process Name - When reviewing running processes on a host, check for the name of the program that
looks suspicious. Sometimes malware uses random names, such as wzuduje.exe. In some cases,
the names might be misleading such as adob3.exe, scvhost.exe, or Microsoft.exe. Being
familiar with Windows processes and any type of internal tool that might be used throughout the
environment, also helps you to identify potentially malicious or suspicious files.

« File Path - Similar to knowing normal and key Windows processes, knowing what path the processes
originate from is a key to detect certain processes that imitate the legitimate process. For instance, if
you see svchost.exe running on a system from
C:\Users\<username>\AppData\Roaming\adobe\ (which is a valid file path), and knowing that
the legitimate Windows process originates from C:\Windows\System32\, you can determine that
the svchost.exe file starting from the C:\Users\<username>\AppData\Roaming\adobe\
directory is the suspicious one. To help determine further identification of a suspicious process,
review the Autoruns tab to see if this process is running as an autorun, service, or task.

« File Signature - When a software package is created, it has a valid digital signature. The following
are a few exceptions:

« If a process that is running is not digitally signed, it does not automatically confirm that the file is
malicious.
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o While files may have a valid signature, it does not mean that they are legitimate. There are

instances of software identified as a Potentially Unwanted Program (PUP) or Adware, which can
have a valid signing certificate.

On Hosts - Indicates the number of hosts on which a file exist. If a file is present on fewer hosts with
a high risk score, it may be malicious and needs further investigation.

Reputation - Leveraging the reputation service is a way to find malicious processes.

Analyze events - For further insight to a process, you can analyze console events, network events, file
events, process events, and registry events.

Network events - Look for any suspicious domains to which the process is connecting. Sometimes
malware creates legitimate connections to a known site, such as google.com, bing.com to hide its
activity on the network. Look for connections to Dynamic DNS domains where a lot of known
malicious activity resides. During analysis, consider uncommon processes making direct
connections to an IP address or to a uncommon port number.

File and process events - Review process interactions that have occurred on the system with the
suspected file. You can look for key events such as writeToExecutable, renameExecutable,
and createRemoteThread, which indicate suspicious behavior.

Leverage other methods

Look up with Google - You can search the file name or hash value against Google to determine if
the file is malicious.

Look up with VirusTotal — You can search the hash value against the VirusTotal to determine if
the file is malicious between multiple AV vendors.

Download file — Download and analyze a file to find indicators such as compile time, imported
DLLs, section names, and performing string searches. Look for TLD values (.com, .net, .biz) or
debug information of a compiled binary (.pdb), which can be easily changed or forged.

Time stamp values — Review modified, accessed, and created dates associated with the binary.
Review how long a file has been residing on a host. While this value is correct most of the time,
attackers can change the time stamp values of a file.

Analyze a Process

Note: Linux is not supported for analyzing a process.

To analyze the process:
Go to Hosts.

1.
2.
3.

Click the hostname.

To analyze process activities of a file, do one of the following:

o In the Host Details tab:

a. Click the alert severity.
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The list of distinct alerts is displayed along with the total number of events associated with the

alert.

b. Click the event header and click the Analyze Process link at the bottom.

o Select the Processes tab and do one of the following:

- Right-click a process and select Analyze Process from the context menu.

- Click Analyze Process in the toolbar.

In the following example, the file powershell has invoked mimikatz, which is a tool to extract
plain text passwords, hashes, and kerberos tickets from memory.

afewsecondsage 11400

DETAILS  PROCESSES ~ AUTORUNS  FILE LIBRARIES  ANOMALIES  DOW|

ALERTS SEVERITY

3

CRITICAL HIGH AL 11/29/201909:59:25000sm  Endpoint

Jevents

C\Windows\System32\

edadaldadSacs77a81bSbbed 128e
'20abfa3715465ad66edScd

‘cmd.exe c\Suspicious bat C\Suspicious.ps1

11/11/201902:41:06 pm

SYSTEM INFO  HISTORY

) Events rolled over due to retention policies or manual deletion will not be available.

ProcessEvent  createProcess

CAWindows\system32\

19316d4266d06776d9b230545903d8cbeaf
0Oeal1520e9c2a7e6d5960b6faddcat

regexe
REG ADD HKCU\Environment Av
UserInitMprLogonScript /tREG_MULTI SZ /d

"CATMP\mim.exe sekurisa-LogGnPasswords
> C\TMP\o.txt*

193160426600b776d9b2305d5903d8cbeBf
0eal1520e9c237e6d5960bofaddcat

15837032

F6D99DB2-9DF2-3FBF-5CTE-66FBADBIODIS
fwendpoint

10125244.230:50005

Clicking Analyze Process displays the process visualization. For each node, the process name, risk

score, and type of activity the selected process has performed (network , file , or registry )
are displayed. Optionally, you can change the time range to view data.

You can view the properties, such as process execution details, file properties of the selected

process in the bottom of the view.
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00.000 pm rs 0 23rTho4 il iconPresent fileversionl...

Suspicious.ps1 | 617 4040KB Crmd Exe . rdata_data, pdata, didat, rsrc. reloc

Note: No result is displayed in the process visualization view if there is no data for last seven days
or if there is no createprocess event.

4. On the right side of the process visualization view:

o Click Events List to view the associated events. You can also filter events based on the events
category. For more information on filtering, see Analyze Events for a Process.

o Click Hosts to view the hosts on which this file is present and the associated risk score. For more
information, Analyze Hosts with File Activity.

o Click Risk Details to view the list of distinct alerts, such as Critical, High, Medium and All. For
more information, see Analyze Hosts Using the Risk Score.

5. Hover over the process name to analyze important process attributes, such as username, launch
arguments, reputation, file status, signer, signature, and file path.
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NT AUTHORITY\SYSTEM

Signed

cwindows\system 32,

cmil.ee c\Suspicious bat
c\Suspscious.psl
(3 Copy Launch Arguments

6. Click @ to view the child processes. The Process selection dialog is displayed with the child
processes associated with the process based on the risk score. You can filter the result on the event
type by clicking icons on the top panel. When no matching event types are available, these filter
options are disabled.

Depending on the type of event, the icons are highlights in the Event Types column.

a. Click View All to view all child processes or select the required processes and click View
selected. The associated events and properties are displayed in the right panel.
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& . © |
b. Click to change the process selection and click to collapse the view.

Al(70) @ Network{12) OFie(s
PROCESS NAME RISE SCORE LAUNCH ARGUMENTS EVENT TYPES

omid exe /i certutil exe -uricadhe -spiit - httpsfraw__ I

o exe
oonhost s (bd T -Forcehfl

omd e o dir /b /&-d Mest-set=\"oollecfion™"hat
ping-n5 127001

Tzee e-bbl -paptsimulsior “Cmimieizenc-files
Tz e-bbl -paptsimulstor “C\mimiatenc-files

omd e fic dir /b /a-d Mest-sets\"oommand-and-con__
Showing 70 out of 70 | 70 selected

0
o
0
0
0
0

70 Process selected Cancel View all View Selected

Analyze Events for a Process

To analyze events for the selected process:

1. Perform steps 1 to 3 in Analyze a Process.

2. In the process visualization, click the Events tab.

3. To narrow down the search to find any suspicious indicators, behaviors, or specific type of event,
filter on a set of matched events based on a category - Process, File, Registry, Network Event, or
Console Event (for Windows).
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For example, to view only process events, select the Process Event category, and filter on action.

EVENT TIME CATEGORY

14,7 AP 065.. Prox et

11703:0..  Process Event

Process Event

Process Event

Process Event

Process Event

Process Event

ACTION

openfr._.
openPr_..
openPr_.
openPr_.
openfr._.
openPr_..
openPr_.

openPr_.

openfr._.

openPr_..
openPr_.

openPr_.

Events Liat

SOURCE FILE NAME
explorerexe
explorer.ave
explorer.eve
explorer.axe
explorerexe
explorer.ave
explorer.ae
explorer.axe
explorerexe
explorer.ave
svrhost e

lsazz.eve

SOURCE PARAMETER

svrhast exe -k netsves -p

SOURCE DIRECTORY
CWYindows',
CWYindows',
C\Windows',
CWindows',
CWYindows',
CWYindows',
C\Windows',
CWindows',
CWYindows',
CWYindows',
CWindows! System 32,

C\Windows! System32,

The result displays the sequence of activities involving this process for the selected filters.

from 11.4 or later agents.

Note: For the console events, the context for local and remote are available only if the data is sent
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Changing File Status or Remediate

information, see the NetWitness Endpoint Configuration Guide.

Note: By default, the blocking option is disabled in the policy. To enable blocking, in the policy
configuration, change the Blocking option to Enabled under Response Action Settings. For more

To change the status of a file:

1. Do one of the following:

o Go to Hosts (Processes, Autoruns, Files, Drivers, Libraries, or Anomalies tab).

o Go to Files.

2. Select one or more files and do one of the following:
RSA te  Respond  Users osts  Files  Dashboards  Reports

S AVEDEITTERS [0  FILENAME RISK SCORE 7 FIRSTSEENTI.. ON HOSTS REPUTATION

Select [O) 06/11/202017... Known Good

Change File Status X . Known Good
FILE NAME

Analyze Events

Equals Known Good

Google Lookup p oot
nown Gox

FILE STATUS VirusTotal Lookup

O Neutral View Certificates Known Good
O Blacklist

O Graylist Download File to Server
O Whitelist

Known Good
Known Good
REMEDIATION PO2A = Known Good

O Blocked
Reset Risk Score a Known

o Right-click and select Change File Status from the context menu.

o Click Change File Status in the toolbar.

admin >

SIZE

9.5MB

143...

362....

(G5O

5 GY7.

. microsoftsigned...

SIGNATURE

microsoft,signed, .

microsoft,signed, ..

microsoft signed, .

microsoft signed....

microsoft signed. ..

microsoft signed, .

microsoft,signed, ..

. signedyalid

PE.RESOUR...

Microsoft C...

Microsoft C...

Microsoft C...

Microsoft C...

Microsoft C...

Microsoft C...

Microsoft C...

Microsoft C...

VMware, Inc.

3. Inthe Change File Status dialog, select a status - Blacklist, Whitelist, Graylist, or Neutral.

FILE §

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral
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Change File Status

STATUS
Blacklist
CATEGORY

Select

REMEDIATION

g is enabled an inates a

O Graylist
O Whitelist
O Neutral

COMMENTS

d file has

ft cannot be blocked.
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Change File Status

STATUS
Blacklist
CATEGORY

Select

REMEDIATION

Applies to Windows hosts running in advanced mode where blocking is enabled and
terminates all processes associated with the selected file hashes.

O Block

O Graylist
O Whitelist
O Neutral

COMMENTS

Note: You cannot whitelist certain Microsoft files, such as cscript.exe, wscript.exe,
cmd.exe, bash.exe, as there is a potential risk of them being used for malicious purposes. For
more information, see Files Restricted from Whitelisting.

If you select Blacklist or Graylist, the following options are displayed:

a. Category: Select the appropriate category type: Generic Malware, APT: Advanced
Persistent Threats, Attacker Tool, Unidentified, Ransomware.

Caution: Before blocking, make sure that you review the file because this may cause the
system or software to be unusable.

b. Remediate: Select Block to block the file.

Note: Blocking is supported only for Windows hosts.
Y ou cannot block the following:

- Memory DLL and floating code

- Files that are signed by Microsoft or RSA.

4. Add a comment and click Save.
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You can change the status of only 100 files at a time. When the status is changed, it impacts the file
status on all hosts on which the file is present. The status is sent as a session under the File category,
and available for investigation. If the file is seen in subsequent scan or tracking, the corresponding
sessions contain a meta value with the file status (except Neutral).

Files Restricted from Whitelisting

To view or update the files that are restricted from whitelisting, do the following:

1.
2.
3.

On the NW server, run the nw-shell command from the command line.

Run the 1ogin command and enter your credentials.

Connect to the Endpoint Server using the following command:

connect endpoint-server

Run the following commands to view the list of files:
e cd endpoint/file/status/restricted/get
e invoke Whitelist

Run the following commands to add files to the list:

e cd endpoint/file/status/restricted/get

e invoke '{"id":"<filename>","restrictedStatus"
"enable":true}

Run the following commands to delete files from the list:
e cd endpoint/file/status/restricted/update

e invoke '"{"id":"<filename>","restrictedStatus"
"enable":false}

:["Whitelist"],

:["Whitelist"],
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Analyzing Downloaded Files

To perform a deep analysis of suspicious files, you can manually or automatically download the file to
the server.

Note: Saving or analyzing downloaded file works the same way irrespective of whether the file is
downloaded manually or automatically.

Note: Downloaded files are stored in the Endpoint Server which may fill up the disk space. To utilize
the storage efficiently without impacting the health of Endpoint Server, RSA recommends you to
configure an external storage mount, so all the Endpoint Server can use the configured location to
store the downloaded data.

By default, all files are downloaded to /var/netwitness/endpoint-server/<files>/. If you
want to change the location, make sure that you have endpoint-server.configuration.manage
permissions and do the following:

1. In the Explore view, go to endpoint/download,

2. In the base-path, provide the location of the directory.

Caution: By default, the status File Download Disk Usage stats in the Health and Wellness view
shows unhealthy if the disk usage reaches 60% and the file download stops automatically when the

disk usage is 70%. You can customize the warning or fatal thresholds in the O > Services >

Endpoint Server > view > Explore > rsa.endpoint.file-download-disk-thresholds.warning-
percent and rsa.endpoint.file-download-disk-thresholds.fatal-percent parameters respectively.

For the downloaded file, you can:

o Search for strings in the executable

« View text content for scripts

« View imported libraries and functions

o Save a local copy for further analysis

Download Files to Server

Downloading file to server is not supported for memory DLL and floating code.

Note: Downloading files may take significant time. Additional requests to the agent during download
are queued and processed when the download is complete.
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Automatic File Download

By default, the files that are unsigned and size lesser than or equal to 1 MB are downloaded
automatically to the NetWitness Endpoint server. And, only single copy of each file is downloaded

>

automatically. You can limit the volume of files to be downloaded in the O > Endpoint Sources
> Policies tab, so the files matching certain criteria are only downloaded automatically. For more
information on automatic file download settings, see "Create an EDR Policy" section in the

RSA NetWitness Endpoint Configuration Guide.

The status of the download is displayed in the Files tab > Downloaded column.

Manual File Download
To manually download files to the server from the Hosts view:
1. Go to Hosts.

2. Select the hostname to open the Host Details view.

3. Inany of the Processes, Autoruns, Files, Drivers, Libraries, or Anomalies tabs, select the file, and
do one of the following:

RSA e

AGENT LAST SEEN AGENT VERSION

100 H AGENT

windows Idle afewseconds ago 11500 snapswor Time  06/28/2020 21:30:08

DETAILS  PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ~ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

Y Filters

« Right-click and select Download File to Server from the context menu.

o Select Download File to Server from the More Actions drop-down list in the toolbar.

Processes

O PRrOCESS NAME

0O 00|00 0/ 0|0

& AnalyzeProcess | | & Change File Status

LOCAL RISK SCORE

Analyze Process
Change File Status
Analyze Events
Google Lookup
VirusTotal Lookup

Download Process Dump fo Server

Download File to Server

To download files to the server from the Files view:

1.

Go to Files.

2. Select the file and do one of the following:

& Analyze Events ‘\/ ‘ $ More Actions v

GLOBAL RISK SCORE

ONHOsTS

REPUTATION

Known Good

Known Good

Known Good

Known Good

Known Good

Known Good

Known Good

Known Good

Known Good

FILE STATUS

Blacklisted

Blacklisted

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral

@) reeview

FILE PATH

CAWindows\System3;

C:\Windows\System3;

CAWindows\System3:

CAWindows\System3:

C:\Windows\System3:

C:AWindows\System3:

CAWindows\System3:

C:AWindows\System3:

C:AWindows\System3:
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RSA estigate  Respond  Users osts  Files  Dashboards  Reports

Y Filters - © endpointbrok... ~ ‘ View Certificates %% Change File Status H O AnalyzeEvents | v || # More Actions v

OGS O ruename RISKSCORE  © FIRSTSEENTIME  ONHOSTS RepuTATION size  siGnaTURE PERESOURCES... FILE STATUS

Select u] 06/12/202011:16:... Known 171.. - Neutral

- [ 89.6KB i VMware, Inc. Neutral

Change File Status
Known 9084... - Neutral

Analyze Events
Known 2560 Neutral

Google Lookup
VirusTotal Lookup S Known Good 1375..  microsoft,signedyalid,.. Microsoft Corpo... Neutral
View Certificates Known Good 741KB  microsoftsignedyalid  Microsoft Corpo... Neutral
Download File to Server : Known Good 353KB  microsoftsignedyalid  Microsoft Corpo... Neutral

Known 141KB  unsigned - Neutral

Known 26KB - Neutral

u}
u}
o
o
o
u}
u}
u}

Reset Risk Score Known Good 6272 signedyal Microsoft Corpo... Neutral

o Right-click and select Download File to Server from the context menu.

o Select Download File to Server from the More Actions drop-down list in the toolbar.

The status of the download is displayed in the Downloaded column. The download statuses are
Downloaded, Not downloaded, and Error.

Save Downloaded Files

You can retrieve a downloaded file and save it to your local file system for further analysis. Downloaded
files are stored in the server in the configured location. This option is enabled only if the file is
downloaded to the server.

To save a file:
1. Go to Hosts or Files .
2. Right-click the file you want to save and select Save a Local Copy.

3. Browse the location and click Save.

Analyze Downloaded Files

You can use the Analyze File option to view detailed information about a downloaded file. This option is
enabled only if the file is downloaded to the server. To analyze a file:

1. Go to Hosts or Files.

2. Right-click the downloaded file and select Analyze File. The File Analysis view opens and
properties of the are is displayed in the right panel.
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Cmd.Exe Details  Ana

ACTIVEON  SIGNATURE size FILESTATUS  OPERATING SYSTEM
70 0 micrasoft signed,valid,catalog ~ 227.5KB  Neutral windows

File Al -5 v FILTER STRINGS  EN

DETAILS
STRING OFFSET UNICODE LENGTH

usebackq 0x00027C88

XAy 0x0000C64A

Show details with values only

NtOpenProcessTokes 0x0002DFEQ File Details

fE9d 0x0001F9AA y e
e sestetl 0x00020184 4f684066175b77€0c3a000549d2922¢
99ae9c73e9bee6fac76d6f4093a9882d1068...

935c1861df1f4018d698e8b65abfa02d7e90...

wescmp 0x0002E0BC

IdpiAware 0x00030C8F
227.5KB

952d%s%! %s902d 0x00027ECO eName  935c1861df1f4018d698e8b65abfa02d7e90...
AcquireSRWLockShared 0x0002D202 varinetwitness/endpoint-server/files/935¢c1
0x00030B00

0x0001FE72 AMD64/x64

0x0002: 4 ExecutableLarge Address Aware
07/16/2016 07:53:21.000 am

0x00012488 0x00015190

0x00028C48
0x0000D10C

Wwindows Console
0x00027CD0

3. View strings in the file in the Strings view while analyzing an executable (such as macho, pe, elf).
This view contains the string, offset in the binary, unicode, and the length of the string. You can
search for or filter on a specific string value in the Filter String field.

4. View the text content of the file and look for any suspicious behavior in the script file.

For example, if the file contains C2 information in the form of domain names or IP addresses, it is
highly suspicious.

oo [ o525
1 idie 5 B o 11/12/2019 05:53:25 pm

ExEd]
DETAILS PROCESSES AUTORUNS FiLes DRIVERS LiBRARIES ANOMALIES DowNLOADS SvYsSTEM

ile Analysis - Stri s m3

sTRING orrser umicope LenaTH
0x00000407 v 19
000000496 v 2
000000828 v 2
t pe
16£277c8d94437b751917087ddc8d91
1 60ec5ca33072dff849a1d9eacda6c20834ad...
5 b266afb334f3dec596dace50170994c8f942.
OKB
< b266afb334f3decs960ac6501170994c942..

Nar/netwitness/endpoint-server/files/b266a

86/x86
= Executable.Large Address Aware
< 017142019 10:20:25.000 am

© 0X00002C4A

n Windows Console

Showing 3 of 123 strings

If you see unprintable keyboard keys listed within the file, such as: [F1], [F2]...[Page Up], [Enter],
[ESC], and so on, that may be indicative of a keystroke logger.
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idie

100

11/12/2019 05:53:25 pm
windows

keEviog|
PROCESSES  AUTORUNS LIBRARIES  ANOMALIES DOWNLOADS  SYSTEM

< Files | | Fi View  ruren strines

DETAILS
stainG orrser unicoe LenaTH DETAIL
el 0x00055070 s

[E=d 0x00055128 Show details with values only

[Right] 0x00055068 File Details
0x0004612F pe
000061510 5242de7eee306123c50c1d0dcad83062
dacca0cf0edbadsScdce6s15e506209C8f18.
0x00055050
9eb0aadOeaa22685a6aceaa24136298472.
0x00056100
401.0KB
s D c9ebaad0eaa22685a6aceaa24136e98472...
fsOni* 0x0005C2F4 Nar/netwitness/endpoint-server/files/coeb0
TCTKISTITnS: 0x00062015

[PageDown] 0:0005511C 1386/x86

=1 e Executable,32-bit
[thunk: 0x00056610 02/22/2019 11:46:23.000 am
01,101at 0X000275FF
S50
3
Windows Console

[Num Lock] 000055218

[End] 000055060

Showing 29 of 1510 strings
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Performing Host Forensics

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.4 and later.

Y ou can perform the following forensic investigation on a host:
« Master File Table (MFT)
o System Dump

o Process Dump

Note: This is applicable only for Windows agent (in Advanced mode) with NetWitness Platform
version 11.4. Downloading system dump files may take significant time. Additional requests to the
agent during system dump download are queued and processed when the download is complete.

MFT, system dump, and process dump downloads are not supported for agents communicating through
Relay server.

Note: MFT, system dump, and process dump are stored in the Endpoint Server which may fill up the
disk space. For large deployments, to utilize the storage efficiently without impacting the health of
Endpoint Server, RSA recommends you to configure an external storage mount, so all the Endpoint
Server can use the configured location to store the downloaded data.

By default, all files are downloaded to /var/netwitness/endpoint-server/<file type>/,
where <file type> is MFT, system dump, or process dump. If you want to change the location,
make sure that you have endpoint-server.configuration.manage permissions and do the following:

1. In the Explore view, go to endpoint/download.

2. In the base-path, provide the location of the directory.

Download Master File Table

Master File Table contains metadata of every file on the host. It keeps track of information, such as
filename, size, timestamps, permissions, and location of the file on the host. It consists of two sets of
timestamps - Standard Information ($SI) and File Name ($FN). Each set has the following timestamps -
creation, access, update, and modification.

Time stomping is a technique that modifies the timestamps for a file (creation, access, update, and
modification time) to mimic files that are in the same folder, making it difficult to identify suspicious
files on a host. To perform forensic investigation of a suspicious file, you can download and analyze the
MFT, and focus on files that are time stomped. For more information, see Analyze Downloaded MFT.

During MFT analysis, you can also search for suspicious filenames, and also files that were created
before or after a known malicious event. You can also download files from the MFT viewer for further
analysis.

Download MFT to Server

To download MFT to the server from the Hosts view:
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1. Go to Hosts and do one the following:

o Select a host and select Download MFT to Server from the right-click context menu, or from the
More drop-down list in the toolbar.

RSA r e d Users  Hosts  Files

< Filters < 8 endpointbrok... »/ ‘ 7 Analyze Events [W @ Start Scan § More Adions v/

O HosTNAME RISK SCORE ¢  OS - DESCRIPTION LAST SCAN TIME USERNAME AGENT LAST SEEN AGENTSCANSTATUS  AGENTGROUPS 1PV

100 Microsoft Windows 10 Enter...  06/28/202021:30:08 WINDWOS10-0... afew seconds ago Idle Windo ity 101252451...

Analyze Events indows 10 Enter... 06/24/202021:30: WINDOWS10\e...  afew secon Idle Windows-security  10125.245.1...

Deee e 67 (Final) 06/29/202014:30:23 - afew seconds ago Idie - 101252442...

Start Scan

Network Isolation

Download MFT to Server

Download System Dump to Server

Download Files to Server

HOSTNAME

Reset Risk Score

Equals

« Select the hostname to open the host details, click E (More) beside the hostname, and select
Download MFT to Server.

RSA ‘ - Hosts

AGENT SCAN STATUS AGENT LAST SEEN
ew seconds ago

100

windows S el

~ Export Host details ~
DETAILS PROCESSES BRARIES ANOMALIES
Export Files
ALERTS SEVERITY d over due to retention policies

1 Network Isolation

i EVENT TYPE
CRITICAL Download MFT to Server 014:02:41000  Endpoint

Download System Dump to Server — iy

Blacklisted File (91)

91 event(s) Download Files to Server

2. View details of the downloaded MFT in the Downloads tab within the host details. For more
information, see Hosts View - Downloads Tab.

AGENT SCAN STATL AGENT LAST SEEN AGENT VERSION

Idle afewseconds ago 11500

DETAILS  PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

Y Filters x  Downloads
0O wame DOWNLOADED  sizE DOWNLOADED TIME suazse FILE PATH
o ) 1973M8 7 minutes ago NA a
C:\Users\"\NTUSER.DAT - - 24 minutes ago -
> C\Users\mmm exelexe\' - adayago =
> ar = = 2daysago

> C\Users\"\

Equals
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Analyze Downloaded MFT

You can use the MFT viewer to begin analysis where you can search for files based on file name, time
stamps, and identify files that are timestomped.

View MFT
To view the content of the downloaded MFT:
1. Go to Hosts.

2. Select the hostname to open the host details and select the Downloads tab.
3. Click the file name. The MFT viewer is displayed.

All available files are displayed in a tree view similar to the Windows Explorer in the All Files
folder. The Deleted Files folder contains a sequential list of all deleted files.

RSA

1m - a few seconds ago 1140/
windows

DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES COWNLOADS EYSTEM INFO

< Downloads || 7 Filters | MFT Viewer

MFT-C'WINDOWS10-2019-11-14T06-47-52- 7772 NAME CREATION TIME ($FN)

E  NWE-Trace-Oclctxt 11/12/2019 07:02:03 pm
J inetpub
J TMP

wampé4
Windows

NWE-Trace-Oacc rar 11/12/2019 11:54:16 am

NWE-Trace-Oacc bt 11/12/2019 1248:33am

NWE-Trace-0f80.rar 11/12/2019 12:08:39 am

J Users

2 ProgramData
Program Files (x86)

] $RecydeBin
Perflogs

] Program Files

-) $Extend

NWE-Trace-0f80.txt 11/11/2019 09:25:01 pm
NWE-Trace-Oa3c bt 11/11/201907:32:11 pm
NWE-Trace-Oc44 - Copy.txt ! 11/11/2019 06:56:29 pm
NWE-Trace-1fc0. et 11/11/2019 05:44:35 pm

) Recovery
) Documents and Settings
System Violume Information

NWE-Trace-Ocd4.txt 11/11/2019 05:43:31 pm
NWE-Trace-0c30.txt 111172019 05:42:05 pm

11/11/2019 05:03:16
DELETED FILES DataCollector01.csv pm

NWE-Trace-264¢ - Copy.tt 11/11/2019 05:02:52 pm
ALL FILES

O
O
U
O
O
U
U
O
O
O
O
O
O
U

NWE-Trace-264c txt 11/06/201% 09:38:24 pm

4. Click P to view the folder structure. Click the row to view the folder content.
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The details of the MFT is displayed in the table. By default, the table is sorted on the creation time

($EN). If the $SI and $FN timestamps are different, the columns are highlighted in red (.)
indicating that it is time stomped.

&

idie afewsecondsago 11400

DETAILS  PROCESSES AUTORUNS  FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

< Downloads || ¥ Fitters MFT Viewer

METCINGSMUDALPLAG 2015-11-29T09-1065-2072 NaME CREATION TIME ($F3) 4 CREATION TIME ($81) MODIFICATION TIME (SFN)  MODIFICATION TIME ($51)  ACCESS TIME ($FN) ACCESS TIME ($51)

ST T B setipactior < 11/19/201906:17063m 11/11/201906:17063m 11/11/201906:1706 3m
Git Origin Master
oo 11/07/201901:022om 11/07/201901:0238 o
) DeepWeb (2015) IVTSAG] 11/07/201901:01:54pm 11/07/201901:01:54 pem 11/077201901:01:54 pm
3 Gt
SysintematsSute 5 110772019 125722 0m 110772019 125732 pm

09/14/201911:54023m 0971472019 11:54023m 09/1472019 11:54023m 971472019 11:540 0571472019 11:54023m
0022/201901:54:19pm 02/22/201901:5419pm Y 09222019015419pm 007227201901:5419 5m
02/22/201901:54:19pm 02/22/201901:5419pm 09222019015419pm 007227201901:54195m
047262019 1044:423m 0472672019 1044423m ’ 2 - 082672019 1044423m 0672672019 10:44:423m

D&/D6/20190531:54pm 04/06/20190531:54pm

5. Select one or more files and click Download File to Server on the toolbar to download files to the
server.

Note: Downloading a folder is not supported and hence the option is grayed out for folders.

Filter MFT

You can filter files on file name, creation time ($FN), creation time ($SI), access time ($FN), access
time ($SI), update time ($FN), update time ($SI), modified time ($FN), and modified time ($SI).

RSA e

te  Responc sers  Hosts  Files  Dashboards  Reports

71 [E

AGENT LASTSEEN  AGENT VER
e idie afewsecondsago 11400

DETAILS  PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS  SYSTEM INFO

¥ Filters X < Downloads

MET-CNGSMUDALPLEC 2019-11-29T09-10-45-3172 (] CREATION TIME (SFN) 4 CREATION TIME ($51)

O Git Origin Feature Branch (m] setupactiog 11/11/201906:17:06am 11/11/2019 06:17:063m
> O GitOriginMaster

> O Temp 11/07/2019 01:03:38 pm 11/07/2019 01-03:38 pm

O DeepWeb (2015) [YTSAG] SMSAdvancedClient configmgr1810-clien... 11/07/2019 01:01:54 pm 11/07/2019 01:01:54 pm
O Git

D SysinternalsSuite 11/07/2019 12:57:32pm 11/07/2019 125732 pm

A ot 09/14/2019 11:54:023m 09/14/2019 11:-54023m
O Intel
O Documents and Settings ) diagwm.aml 08/22/2019 01:54:19pm 08/22/2019 01:54:19 pm
> O Windows
diagerrsam 08/22/201901:54:19pm 08/22/201901:54:19 pen
> 0 Recovery
@) customDare ) X ) .
> O Users DiskcCleanupV3.exe 06/26/2019 10:44:42am 06/26/2019 10:44:42am
O ProgramData
> O Program Files (x86)

> [ $RecydeBin

06/06/2019 05:31:54 pm 06/06/2019" 54pm

@ ) cusToMDATE

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click W

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

To filter, save, and delete MFT, see Filter Downloaded Files, Save Downloaded File, and Delete
Downloaded Files.

72 Performing Host Forensics



NetWitness Endpoint User Guide

System and Process Memory Dump

To perform forensic investigation during an incident response, you can request a memory dump of a host
or a process running on the host. You can analyze these dumps using third-party tools, such as Volatility,
Rekall.

Download System Dump to Server

To download system dump to the server from the Hosts view:

1. Go to Hoests and do one the following:

o Select a host and select Download System Dump to Server from the right-click context menu, or
from the More drop-down list in the toolbar.

Hosts Files D

X B endpointbrok... [ Analyze Events J Start Scan

D HOSTNAME RISK SCORE + OS- DESCRIPTION
O N Microsoft Windows 10 Pro for Workstati...

(| N/A Red Hat Enterprise Linux- 7.2

N/A Red Hat Enterprise Linux- 7.2

“nterprise
Analyze Events

Delete

x 8.1 (Ootpa)
Start Scan

:ducation

Network Isolation % [ierprise

‘nterprise
Download MFT to Server
Equals

Download System Dump to Server

USERNAME Download Files to Server

Equals .
Reset Risk Score

MICrosoTt Windows 7 Enterprise

« Select the hostname to open the host details and select Download System Dump to Server from
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the More option besides the hostname.

RSA

100 - s N STATUS AGENT LAST SEEN

ew seconds ago 11.5.0.0

windows Start Scan

Export Host details . )
DETAILS PROCESSES LIBRARIES ANOMALIES

Export Files
ALERTS SEVERITY olled over due to retention policies

2 Network Isolation

_ _ Download MFT to S 1E EVENT TYPE
N wnioa 0 erver 202013:40:54000  Endpoint

Download System Dump to Server .
Blacklisted File (28) i

28 event(s) Download Files to Server

2. View the details of the downloaded system dump in the Downloads tab within the host details. For
more information, see Hosts View - Downloads Tab.

Download Process Dump to Server
To download process dump to the server:
1. Go to Hosts.

2. Select the hostname to open the host details.

3. Inthe Processes, Libraries, or Anomalies tab, select Download Process Dump to Server from the
right-click context menu, or from the More drop-down list in the toolbar.

RSA

100 : N STATUS af;w;co;d;:go 11?; '0‘““"‘“ SNAPSHOT TIME  06/24/2020 21:30:33
windows 5.0 _—

DETAILS PROCESSES ~ AUTORUNS FILES DRIVERS LIBRARIES ~ ANOMALIES DOWNLOADS SYSTEM INFO HIST

Y Filters X Processes | @ AnalyzeProcess || @:ChangeFileStatus || 7 AnalyzeEvents | || % MoreActions v @ ) TReEViEW

PROCESS NAM [0  PROCESS NAME LOCAL RISK SCORE  GLOBAL RISK SCORE  ON HOSTS REPUTATION FILE STATUS DOWNLOADED

Equals 100 100 2 Known Good Blacklisted
FILE STATUS - 100 2 Known Good Blacklisted

O Neutral Analyze Process

O Blacklist Change File Status

O Graylist ”
r 1>\ I . Analyze Eres 100 2 Known Good Neutral
O Whitelist

100 2 Known Good Neutral

Google Lookup 100 Known Good Neutral

REPUTATION VirusTotal Lookup 100
(mEVET
O Suspicious Download Process Dump to Server Known Good Neutral

Known Good Neutral

O Unknown

O Known Download File to Server KhosniCood eual
O Known Good

O Invalid

Known Good Neutral

Known Good Neutral

4. View the details of the download process dump in the Downloads tab within the host details. For
more information, see Hosts View - Downloads Tab.
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To filter, save, and delete system dump or process dump, see Filter Downloaded Files, Save
Downloaded File, and Delete Downloaded Files.

The following are some errors you might encounter during system and process dump download:

Issue Explanation

Parameter is incorrect. The process for which the dump is requested might be
running with a different process ID.

Element not found The process for which the dump is requested is no longer
active.

java.io.IOException:Unable to unwrap Connection to the agent is interrupted.

data, invalid status [CLOSED]

java.net.SocketTimeoutException The network is slow or the system is down.

One or more arguments are not correct Agent might be in the Insight mode or driver is not
running.

Download Files Using Full Path or Wildcard

Y ou can manually download files that help in investigations by either providing full path of the file or
using wildcard.

Note: This is applicable only for agents in Advanced mode with NetWitness Platform version 11.5 and
later.

To download files to the server:
1. Go to Hosts and do one of the following:

o Select one or more hosts from the same operating system, and select Download Files to Server
from the right-click context menu, or from the More drop-down list in the toolbar. You can
download files from only top 100 selected hosts at a time.

RSA  investigate espond  Users  Hosts  Files  Dashboards  Reports

Y Filters X S endpointbrok... v # Analyze Events | v || @ Start Scan % More Actions v/ &
s 5o e . GeNT scaN sTATUS

O HOsTNAME

ity 101252451

Analyze Events

ndows-security 10125245.1...

Delete
101252442...
Start Scan

Network Isolation

Download MFT to Server

Download System Dump to Server

Download Files to Server

Reset Risk Score

« Select the hostname to open the host details, click E (More) beside the hostname, and select
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Download Files to Server.

RSA

100 H AG SCAN STATUS AGENT LAST SEEN

. ) ‘ew seconds ago
windows Start Scan

Export Host details

DETAILS PROCESSES AU LIBRARIES ANOMALIES

Export Files
ALERTS SEVERITY olled over due to retention policies

2 Network Isolation

EVENT TYPE

TG Download MFT to & 2
. o3 Oenver §02013:40:54000  Endpoint

Download System Dump to Server A

28 event(s) Download Files to Server

2. Inthe Download Files to Server dialog, enter the full path where the files may be present or search
using wildcard. For wild card search, you can use a maximum of two *, one at a folder level and the
other at a file level.

For example, to retrieve the registry hive, you can enter the full path,
C:\Windows\System32\config\SYSTEM.

If you want to retrieve user settings and configuration preferences for all users, download all files
using the wildcard C: \Users\*\NTUSER.DAT.

Download Files

FILE PATH

C\Users¥\NTUSER DAT]

MUMBER OF FILES FILE SIZTE[MB)

3. For wildcard search, enter the number of files to download and size of the file. By default, the
number of files is set to 10 and file size is set to 100 MB. For example, if the maximum number of
files is set to 10 and file size is set to 10 MB, first 10 files within 10 MB are downloaded.

4. Click Download.
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All files downloaded as a part of wildcard search are grouped together based on the search criteria. For

example, all files downloaded using C: \Users\*\NTUSER.DAT are grouped, and you can click B
expand and view all files under this group. You can sort the groups on the downloaded time and view the
status of the download in the Downloaded column.

Dashboards

4]

Idle afew seconds ago 115.00

DETAILS  PROCESSES  AUTORUNS  FILES DRIVERS  LIBRARIES ANOMALIES DOWNLOADS  SYSTEM INFO

¥ Filters X Downloads

0O Name v DOWNLOADED  size DOWNLOADED TIME SHA256 FILE PATH

[0 > C\Users\"\NTUSER.DAT - v - 8 minutes ago

adayago

v
v - 2daysago
v

Filter Downloaded Files

You can filter the downloaded files on wildcard downloads, file type, file name, SHA256 (for files), and
downloaded time. In the Downloaded Time field, you can also filter by custom date.

Idle afew seconds ago 115.00

DETAILS PROCESSES AUTORUNS  FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS  SYSTEM INFO

¥ Filters x  Downloads

O  Name YPI DOWNLOADED 1 DOWNLOADED TIME FILE PATH
o v 7 minutes ago <
) > C\Users\'\NTUSER.DAT 24 minutes ago

0 > C\sers\ \Desktop\exe\exe\" adayago

v
v

O > e - v - 2daysago
v

0 > C\Users\y W

Equals

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click W

Note: Special characters are not allowed except underscore () and hyphen (-) while saving the filter.

Save Downloaded File

You can retrieve the downloaded file and save it to your local file system for further analysis. To save
the file:
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1. Go to Hosts.
2. Select the hostname to open the host details and select the Downloads tab.

3. Right-click the file you want to save and select Save a Local Copy from the context menu or from
the toolbar.

Report

Idle afewsecondsago 11500

DETAILS  PROCESSES AUTORUNS  FILES DRIVERS  LIBRARIES ANOMALIES DOWNLOADS  SYSTEMINFO  HISTORY

Y Filters Downloads Save a Local Copy Delete File

0 wame TYPE DOWNLOADED  SIZE DDOWNLOADED TIME SHA256 FILE PATH

MFT V) 197.3M8 7 minutes ago NA a

S Local Ce
ave a Local Copy v
Delete File v

o FILE

[0 > C:\Users\"\NTUSER.DAT 24 minutes ago

0 > C\Users)

4. Browse the location and click Save.

Note: For wildcard downloads, select a file from the group that are downloaded successfully to save a
local copy. You cannot save multiple files in the group at a time or save files with errors.

Delete Downloaded Files

If you want to delete the downloaded file from the server:
1. Go to Hosts.

2. Select the hostname to open the host details and select the Downloads tab.

3. Right-click one or more files you want to delete, and select Delete File from the context menu or
from the toolbar.

RSA

AGENT SCAN STATU AGENT LAST SEEN AG
100 windows Scanning afew seconds ago 11.

DETAILS ~ PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES ~ANOMALIES DOWNLOADS  SYSTEMINFO  HISTORY

Y Filters Downloads Save a Local Copy Delete File

DOWNLOADED  SIZE DOWNLOADED TIME SHA256 FILE PATH

0 name TveE

v

. MFT
[0 > C\Users\"\NTUSER.DAT Save a Local Copy L/
0 > c\wsers\ Delete File v

197.3M8 7 minutes ago

- 24 minutes ago

o\

Note: For wildcard downloads, you can select the group to delete all files that are downloaded.
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Analyzing Events

If you need to investigate a particular host, [P address, username, filename, or hash to look for related
activity across a time range, you can pivot to Navigate view to get the entire context of the activity. By
default, the time range is set to 7 days. You can change the time range.

Note: By default, the system detects the best data source to pivot to Navigate view. To change the
data source, modify the investigate service ID under endpoint or investigate in the Explore view.

Analyze Events from Files View

To investigate a particular filename or hash (SHA256 and MDS5):
1. Go to Files.

2. Select the file you want to analyze and do one of the following:

o Right-click and select Analyze Events from the context menu.
o Click Analyze Events in the toolbar.
RSA e Respond  Users osts  Files

Y Filters X B endpointbrok... View Certificates 4% Change File Status 4 Analyze Events | v % More Actions
SAVED RISKSCORE  © FIRST SEEN TIME REPUTATION size SIGNATURE
Select

. Change File Status
Equals

Fquals Analyze Events Console Events
Coodiolbookin) Network Events

VirusTotal Lookt
e ) File Events
VEDEIIETE Process Events

Download File to Server Registry Events

Reset Risk Score

m}
o
o
o
o
m}
o
o

This opens the Navigate view with data related to the file. For more information on analyzing events
in the Navigate and Events views, see the NetWitness Investigate User Guide.

Note: If the values are not indexed, the results take time to load. For more information, see
Troubleshooting NetWitness Endpoint.

Analyze Events from Hosts View

To investigate a particular host, IP address (IPV4), or username:
1. Go to Hosts.
2. Do one of the following:

o Right-click a host, select Analyze Events from the right-click context menu or in the toolbar, and
select a specific event type (such as network events, file events) that you want to view.

« Select the hostname to open the host details. Right-click a file or in the toolbar, select Analyze
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Events, and select a specific event type that you want to view.

The following figure is an example of the Autoruns tab.

v
% @ admin)

AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

SNAPSH(C /. :30:
Idle afew seconds ago 11500 SNAPSHOTTIVE w

DETAILS ~ PROCESSES ~ AUTORUNS  FILES ~ DRIVERS ~ LIBRARIES ~ ANOMALIES ~DOWNLOADS  SYSTEM o .

Y Filters % Autoruns es Tasks

FILE NAME W ChangeFileStatus | | (7 Analyze Events

Equals
[  FILENAME LOCALRISK SCO.. GLOBALRISKSC.. ONHOSTS  REPUTATION FILE STATUS DOWNLOADED

FILE STATUS (©) Known Neutral

O Neutral

O Blacklist Change Fie Status Known Neutral
O Graylist Analyze Events
O Whitelist

Console Events Known Neutral

Corgollwy Network Events Known Neutral
T AT ‘ ( N VirusTotal Lookup Fie Events ‘oo et
g Ll’i l;:::; Download File to Server Process Events
O Unknown Registy Evenls

O Known T Known Neutral
Showing 143 out of 143 autoruns | 1 selected

This opens the Navigate view with data related to the file.

Known Neutral

For more information on analyzing events in the Navigate and Events views, see the NetWitness
Investigate User Guide.

Text Analysis for an Endpoint Event

You can view all Endpoint events in their original text format in the Events view Event List panel. When
you click an event in the Event list panel, the adjacent panel shows the Text Analysis. Pagination
controls add flexibility when paging through the reconstructed text of an event. The Text Analysis
displays the following:

« Event Header, which provides summary information about the event. (Version 11.5 and Later) The
event header includes host name, process, and user name details in addition to other event details if
the selected Endpoint event contains these metadata.

« Options for exporting - log, csv, xml, and json formats.
« Option to pivot to the Endpoint Thick Client to analyze the meta value.
« Option to analyze process details associated with the event.

o Option to view the host details for further analysis.

Below is an example of the Process event for Endpoint. The text in the Text Analysis panel explains that
a source process WmiPrvSE.exe opened a browser process named chrome . exe. In the events, if there
is a meta value that exceeds 255 characters, the value is displayed in the Large Meta Values panel.
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© EPS1-Server - Concentrator V' | | 02/27/2019 07:43am - 03/26/2019 07:42am openbrowserprocess ' x

5,423 Events (Asc) ~ X Endpoint Event Details | Text Analysis
e e s
Download Log [2 Pivot to Endpoint Thick Client [2 Analyze Process [2 Pivot to Host Overview

03/14/201909:4134am  Endpoint 2019-03-14T02:

NW SERVICE SESSION ID NWE CATEGORY COLLECTION TIME EVENT T
EPS1-Server - Concentrator 6965 Process Event 03/14/2019 09:41:34 am 03/14/2019 09:36:26 am
03/14/201909:41:34am  Endpoint 14T09:36:.

03/14/201909:41:34am  Endpoint

031472019 09:4134am  Endpoint ® 03/14/2019 09:36:26 an @ @ NT AUTHORITY\NETWORK SERVICE sessionip
TimE
WniPrVSE.exe openBrowserpros chrome. exe e
03/14/201909:4134am  Endpoint FORWARD.IP
1P.ALL
03/14/201909:4134am  Endpoint ; . A MEDIUM
paran. dst=chrom rashpad-handler "--user-data-dir=C:\Users\ \AppData\Local\Google\Chrome\U: DEvICETYPE P
Data” /prefetch: itor-self-annotation-ptype-crashpad-handler "-- DIRPATHSRC I

03/14/201909:4134am  Endpoint . \AppData\Local\Google\Chrome\User Data\Crashpad” "--metrics- DIRPATHALL s
\AppData\Local\Google\Chrome\User Data” --ur! /clients2.google.com/cr/report - DIR.PATH.SRE windowsSystem32
-annotation-plat=Hin64 --annotatio .3683. iti DIRPATHALL windowsSystem32

client-data=ex1e8,0x1ed, 0x1e8,8x1dc, Ox1ec, Bx7 FFa64916830, x7Fa64916840,, 0x7F 264916850 CONTEXT.SRC file-found

03/14/201909:41:34am  Endpoint

CONTEXT.ALL file:found
03/14/201909:41:34am  Endpoint coNTEXT.sRC fle.protected

CONTEXT.ALL fle proteced

3am - 03/26/2019 07:42am  V network event

22,535 Events (Asq) < Endpoint Event Details | Text Analysis m|

Download Log [3 Pivot to Endpoint Thick Client | | [3 Analyze Process | | [3 Pivot to Host Overview

COLLECTION TIME Tvee EVENT TIME

NW SERVICE sEssIoN 1D NWE CATEGORY coLLECTION TiME EVENT TIME
_ EPS1-Server - Concentrator 6768 Network Event 03/14/2019 09:41:34 am 03/14/2019 09:34:15 am
03/14/201909:41:34am  Endpoint :34:. :10003

NETWORK REMOTE ADDRESS

03/14/201909:41:34am  Endpoint

031472019 09:4134am  Endipoinc © 03/14/2019 09:34:15 an @ @ NT AUTHORITY\SYSTEM sessioniD
TIME
03/14/201909:4134am  Endpoint . secureConnector. exe 10.254.20.23 ; size
FORWARD.IP
1P.ALL

03/14/201909:41:34am  Endpoint
MEDIUM

paran. src=SecureConnector.exe -performer -id ADGAB2C2CAS54FBF9AC3109807DC7148 -token pevice.Tve P—

031472019 0%:4134am  Endpoint €22114e7617841b0392af5464293e€4600269dc -ip 10.254.20.237 -port 10003 -sha2s

PORT.DST 10003
34E3B6B148C6FICBDAERBCOBABY1 FA42F7291DBBOFD4@0355880226252628B5D ~1Cif 7 -event PORT.ALL 10003
FSA_TMP_5388_5C89DE73_B@G2PERFORMER_CNTL -rrd @ PORT.DST.ALL 10003
03/14/201909:4134am  Endpoint
DIRPATH.SRC programfiles
DIRPATHALL programfiles
03/14/201909:4134am  Endpoint :34:. CONTEXT.SRC fle.autorun
CONTEXT.ALL file.autorun
CoNTEXT.SRC file.found
03/14/2019 09:41:34am  Endpoint
file.found

fle cratedinlasiMont

For more information on Events view, see the NetWitness Investigate User Guide.
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Isolating Hosts from Network

Note: By default, the network isolation option is disabled in the policy, and you cannot view options
mentioned in this section. To enable network isolation, in the policy configuration, select Enabled in
the Network Isolation option under Response Action Settings. For more information, see the
NetWitness Endpoint Configuration Guide.

To isolate a host from the network:

1. Go to Hests and do one of the following:

o Select a host and select Network Isolation > Isolate from Network from the right-click context
menu, or from the More drop-down list in the toolbar.

RSA n e Hosts  Files

Y Filters 7 Analyze Events J Start Scan

] HOSTNAME RISK SCORE + OS-DESCRIPTION LAST SCAN TIME
NA Microsoft Windows 10 Pro for Workstati... 05/08/202002:2

NA Red Hat Enterprise Linux- 7.2 05/05/2020 05:5]

anaged NA Red Hat Enterprise Linux-7.2 05/06/2020 07:3
O Roaming

O Isolated

— 05/06/2020 07:4
Analyze Events
05/05/2020 010
Delete

Start Scan 05/06/2020 07:2¢

Network Isolation 2 | Isolate from Network
HOSTNAME Download MFT fo Server

Equals .
Download System Dump to Server (C sl

USERNAME Download Files to Server 05/06/2020 07:3

Equals Reset Risk Score

e Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Isolate from Network.

R S A I - d Users Hosts

100 AGENT SCAN STATUS AGENT LAST SEEN AGENT VERS

o - few seconds ago 11.5.00
WIIERE Start Scan

Export Host details
DETAILS PROCESSES LIBRARIES ANOMALIES

Export Files
ALERTS SEVERITY rolled over due to retention policies

2 Network Isolation Isolate from Network

CRITICAL Download MFT to Server

Download System Dump to Server
Blacklisted File (28)

I e ) Download Files to Server
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2. In the Isolate from Network dialog, by default, a set of IP addresses are excluded from isolation. For
more information, see Network Isolation. To add IP addresses to the list, select the Add your IPs to
Exclusion List checkbox. You can enter up to 100 IP addresses separated by comma.

|solate from Network

Network Isolation blocks the host from connecting to the networl.
All attempted network connections are monitored and reported to the
Endpoint Server.

Add IP ad

3. Enter comments.

4. Click Isolate Host.

Edit Exclusion List

To edit the exclusion list:

1. Go to Hosts and do one of the following:

« Select a host and select Network Isolation > Edit Exclusion List from the right-click context
menu, or from the More drop-down list in the toolbar.
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RSA Investi d J Hosts Files BE ds R
Y Filters X [ Analyze Events J Start Scan

HOSTNAME RISK SCORE <  OS- DESCRIPTION LAST SCAN TIME

NA Microsoft Windows 10 Pro for Workstati.. 05/08/202002:21:}

O
O
O NA Red Hat Enterprise Linux- 7.2 05/05/2020 05591
O

NA Red Hat Enterprise Linux- 7.2 05/06/202007:384
O Roaming —

3 =
o 05/06/2020 07:47}
Isolated Analyze Events

5, 207
Delete 05/05/2020 01-07

Start Scan - 05/06/2020 07:207]

Network Isolation > | Release from Isolation

Edit Exdusion List
Download MFT to Server

Equals
- Download System Dump to Server 05/07/202008:44;

USERNAME Download Files to Server 05/06/202007:32

Equals Ent: ue Reset Risk Score

Microsoft Windows 7 Enterprise 05/08/2020 06:53]

e Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Edit Exclusion List.

RSA r = J Hosts Files

AGENT SCAN STATUS AGENT LAST SEEN AGENT VE

‘ew seconds ago 11.5.00

100

windows

Start Scan

~ Export Host details
DETAILS PROCESSES AUTO BRARIES ANOMALIES

Export Files
ALERTS SEVERITY bd over due to retention policies g

1 Network Isolation Release from Isolation

CRITICAL Download MFT to Server Edit Exclusion List

Download System Dump to Server —

Blacklisted File (21)

91 event(s) Download Files to Server

2. Add or modify the IP addresses in the list.

3. Enter comments and click Save.

Release Isolated Hosts

Releasing the isolated host restores the network connection and removes IP addresses added to the
Exclusion list. To release the host from isolation:

1. Go to Hosts and do one of the following:

o Select a host and select Network Isolation > Release from Isolation from the right-click context
menu, or from the More drop-down list in the toolbar.
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RSA

Y Filters

Hosts Files

=] endpointbrok...

HOSTNAME

[ Analyze Events . ) Start Scan

RISK SCORE + OS-DESCRIPTION

NA Microsoft Windows 10 Pro for Workstati...
N/A Red Hat Enterprise Linux-7.2

N/A Red Hat Enterprise Linux- 7.2

indows 8.1 Enterprise

Analyze Events

Delete 04.4LTS

Start Scan erprise Linux 8.1 (Ootpa)

indows 10 Education

Network Isolation Release from Isolation

Edit Exclusion List
Download MFT to Server

Download System Dump to Server 04.6LTS

Download Files to Server ux 8 (Core)

Reset Risk Score

indows 10 Education

Microsoft Windows 7 Enterprise

e Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Release from Isolation.

RSA

100 =

windows

DETAILS PROCESSES AUTO

ALERTS SEVERITY

1

CRITICAL

Blacklisted File (91)

21 event(s)

Start Scan
Export Host details

Export Files

Network Isolation

Download MFT to Server

Download System Dump to Server

Download Files to Server

2. Enter comments and click Release Host.

BERARIES

ANOMALIES
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NetWitness Endpoint with Third-Party Antivirus

Products

If you want the NetWitness Endpoint agent to coexist with any of the security products, make sure to
whitelist the agent. For more information, see the respective third-party product documentation.

NetWitness Endpoint with Third-Party Antivirus Products
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Troubleshooting NetWitness Endpoint

This section provides information about possible issues when using NetWitness Endpoint.

General Issues

Some of the hosts or files data are not displayed when Endpoint Broker is selected for
querying.

The Endpoint Broker aggregates data from all Endpoint Servers, which responds within 10
seconds. You must increase the query timeout value to see the result of Endpoint server that
is online. Perform the following:

Q
1. Goto (Admin) > Endpoint Broker service.
2. Click e > View > Explore.

3. Click endpoint/broker node.

4. In the query-timeout field increase the value, for example, 30 seconds.

The Endpoint Agent is unable to communicate with the Endpoint Server. The connection
may not be established due to any of the following issues:

« UDP
« HTTPS

o Firewall

« To verify the UDP or HTTPS connection, you must verify the connection between
Windows Endpoint Agent and Endpoint Server:

1. Go to System32 folder using the following command:
cd C:\Windows\System32

2. Execute the following command:

<Agent Service name>.exe /testnet
For example, NWEAgent.exe /testnet

o If the issue is with the firewall, check the incoming and outgoing firewall rules.

The Endpoint Agent is unable to communicate with the Log Decoder. The connection may
not be established due to any of the following issues:

« UDP
« TCP
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o« TLS
« Firewall
o To verify the UDP, TCP, and TLS connection, you must verify the connection between
Windows Endpoint Agent and the Log Decoder:
1. Go to System32 folder using the following command:
cd C:\Windows\System32
2. Execute the following command:
<Agent Service name>.exe /testlognet
For example, NWEAgent.exe /testlognet
o If the issue is with the firewall, check the incoming and outgoing firewall rules.

Multi-server Issue

Agent is not communicating with the Endpoint Server after migration.

Check the Nginx logs of the Endpoint Server to which the agent has migrated, and if the
agent is communicating with error code 403, that means the certificate of the first Endpoint
Server and second Endpoint Server are different. This is because during the installation of
second Endpoint Server, the certificate of first Endpoint Server is not copied to the second
Endpoint Server.

Reinstall the second Endpoint Server by copying the certificate of first Endpoint Server, and
reinstall the agent. For more information, see the Physical Host Installation Guide.

Hosts View Issues

An error has occurred. The Endpoint Server may be offline or
inaccessible.

When attempting to access the Hosts or Files view, the view opens with the message.

Endpoint Server or Nginx Server is not running. Check the status of the Endpoint Server

under (Admin) > Services or check if the Endpoint Server host IP address is
registered with the Admin Server. For more information, see the Physical Host
Installation Guide or Virtual Host Installation Guide. 1f the service is not running, start
the Endpoint Server.

Files View Issues

Unable to analyze events from Hosts and Files view.
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Other than Broker or Concentrator, if any aggregation service, such as Archiver, is
aggregating data from the Log Decoder that is configured for metadata forwarding from
any Endpoint server, clicking Analyze Events from Hosts and Files view for this
Endpoint server may not work. To resolve this issue:

Note: To get the investigate-service-id:

4
1) Go to (Admin) > Services > Concentrator service.

2) Click 250 View > Explore tab.
3) Expand the sys/stats node list.
4) In the UUID filed, copy the value.

Q
1. Goto (Admin) > Services > Endpoint Server service.

o 08

2. Click > View > Explore tab.

3. In the endpoint/investigate field, specify the investigate-service-id.

Policy Issue

Policy status in the Policy Details panel is not updated or shows Policy
Unavailable/Permission Required.

Policy Unavailable - Hosts belong to previous versions, such as NetWitness Platform
11.1 or 11.2, where a policy is not applied.

Permission Required - If you do not have permissions, see the "Role Permissions"
topic in the System Security and User Management Guide.

Policy Status shows error.

Policy may have wrong configurations. Check the error description, logs in Endpoint
server, and audit logs for details. Contact your system administrator with the error
details.

Driver Issue

While loading the driver on the host, an error is encountered.

Check the driver error code in the Agent-Driver Error Code column under Hosts
view. Contact your system administrator with the error code.

Troubleshooting NetWitness Endpoint



NetWitness Endpoint User Guide

File Reputation Service Issue

When you configure RSA Live for the first time and the File Reputation service is not
connected.

Y ou must manually enable the File Reputation service. To enable the File Reputation
service:

Q
1. Goto (Admin) > System > Live Services.
2. In the Additional Live Services section, select the enable File Reputation check box.

3. Click Apply.

Risk Scoring for Hosts or Files Issue

NetWitness Endpoint takes a long time to process risk scoring for Hosts or Files.

Check the backlog of alerts for risk scoring.
1. SSH to the ESA Primary appliance.

2. Execute the following command:

mongo respond-server --authenticationDatabase admin -u deploy
admin -p <deploy admin password> --eval 'db.staging.find({"$or":
[{state:"STAGED"}, {state :"WORKING"}]}).count()' --quiet

The backlog count is displayed. If the backlog count is 1 million or greater, you must
disable the risk scoring and Endpoint ESA alerts.

3. To disable risk scoring:
.y
a. Goto (Admin) > Services > Respond service.

b. Click & > View > Explore.
c. Expand the respond/scheduled/jobs node list.

d. In the risk-scoring-enabled field, set the value to false.
4. To disable Endpoint ESA alerts:
a. To disable NetWitness Endpoint ESA alerts generation for severity; Critical, High
and Medium.
i. Goto (Configure) > ESA Rules.
The Configure view is displayed with the Rules tab open.

ii. In the Options panel, under Deployments, select the Endpoint deployment to
delete.
A confirmation dialog is displayed.

iii. Click Yes.
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b. To disable only Medium severity NetWitness Endpoint ESA alerts:

QA
i. Goto (Admin) > ESA Correlation service (on which Endpoint deployment
is added).
i, Click & 7 > View > Explore.

iii. Expand the correction/alert node list.

iv. In the transient-enabled field, set the value to false.
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This section is intended to help you understand the purpose and application of NetWitness Investigate >
Hosts view and Files view. For each view, there is a brief introduction and a What Do You Want To Do
table with links to related procedures. In addition some of the reference materials include workflows and
Quick Looks to highlight important features in the user interface.

o Files View
o Hosts View

o Hosts View - Details Tab

e Hosts View - Process Tab

e Hosts View - Autoruns Tab

o Hosts View - Files Tab

o Hosts View - Drivers Tab

o Hosts View - Libraries Tab

e Hosts View - Anomalies Tab

e Hosts View - Downloads Tab

o Hosts View - System Information Tab

o Hosts View - Agent History Tab
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Files View

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The Files view provides a holistic view of all files in your deployment. To access this view, go to Files.
By default, the Files view displays 100 files. To display more files, click Load More at the bottom of
the page.

You can either view files specific to an Endpoint server or view all files from multiple Endpoint servers
by selecting the Endpoint Broker.

Workflow

Analyze Events

(Navigate or Event
Analysis View)

Whitelist Files/ Create Fikier &
reate Filter to
Certificates Signed by Identify Files Anal Fil > Download Files for
entify Files for nalyze Files
Known Good y_ ) Y Deeper Analysis
Investigation
Vendors

Perform External

—

—

Lookups

What do you want to do?
User
Role
Threat whitelist files and certificates signed by known good  Analyze Certificates
Hunter vendors*
Threat create filter to identify files for investigation™® Filter Files
Hunter -
Threat analyze files* Investigating Files
Hunter
Threat analyze events™ Analyzing Events
Hunter
Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter
Threat perform external lookups* Launch an External Lookup for
Hunter a File
Threat change file status or remediate* Changing File Status or
Hunter Remediate

*Y ou can perform this task in the current view
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Related Topics

o Focusing on Endpoint Analysis

o Investigating Hosts

o Analyzing Downloaded Files

o Analyzing Events

o Analyze Certificates

o Changing File Status or Remediate

Quick Look

Below is an example of the Files view:

RSA g d U Files ard  Reports

Y Filters S endpointbrok... View Certificates “# Change File Status Z Analyze Events . # More Actions v

O Fename

3]

4 FIRSTSEENTIME ON HoOsTS. RePUTATION

06/23/202008:36:49am 2 =

06/23/202008:36:49am 2

07/06/202007:10:55

07/06/202007:1¢

07/06/202007:10:58.

07/06/202007:10:55

07/06/202007:10:58 3m

07/08/202012:50:26 pm

07/06/202007:10:58 3m

07/07202005:52:223m

07/07/202005:52:22.

07/08/202007-10:58

07/06/202007:10:55

07/06/202007:10:55

07/06/202007:10:58 3m 36: microsoft signedy

07/06/202007:10:58 am microsoftsignedy

07/06/202007:10:58 3m

07/06/202007:10:55

07/06/202007:10:55 1055K8

07/06/202007:1¢ 155K8  microsoftsignedy

4“ o | |F1LE DETAILS

nlaapi.dil

e nlaapidil

6426718559932449

85KB

e [

= microsoft,signedyalidcatalog

P 06/06/20200: .356am

24341b9fd50b9964283220a36...

zner Microsoft Windows

D3 fb7ddd5b0f0da76c4ed1943233...
1 0e472395e6999e0b22116c298...

56 b487a51F296c9feead619eb4223...

Filter Files. You can filter the files by selecting the options in the Filters panel and create
filters. For more information, see Filter Files.
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Actions in the toolbar:

Server drop-down list - You can select the Endpoint server or Endpoint Broker server to view

the hosts.

View Certificates - Provides a list of code-signing certificates reported by hosts found in your

deployment and their associated properties. For more information, see Analyze Certificates.

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected files to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, [P address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
o Perform external lookups.
o Download files to server, save a local copy, and analyze files for deeper analysis.

o Reset risk score.

Note: You can perform the above actions from the right-click context menu.

Sort Columns. Lets you sort on column titles.

Settings Menu. You can set Files view preferences by selecting columns from the Settings
menu. For more information, see Set Files Preference.

Show/Hide File Properties Panel. Click a row to show or hide the File Properties panel. It
displays the following tabs:

File Details - Displays the file information.

Risk details - Displays the distinct alerts associated with the risk score.

Hosts - Displays the top 100 hosts based on the risk score on which the file is present. For more

information, see Analyze Hosts with File Activity.

Export to CSV - Extracts global files to a CSV file. For more information, see Export Global
Files.

File Details View

To access this view, go to Files, and select a file. Below is an example of the File Details view:

95
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I Agent and Scan Details. You can view the following agent and scan details of the selected host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.
Operating System - Operating system on which the agent is running (Linux, Windows, or Mac).

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or hash
to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to perform external lookups.

On Hosts - Indicates the number of hosts on which a file exist.
Signature - Provides signatory information.

Size - Size of the file.

File Status - Status of the file. For example, Neutral.
P Details tab - Displays list of distinct alerts, such as Critical, High, Medium and All, along with
the total number of events associated with the alert.

Analysis tab - Provides detailed information about a downloaded file. For more information, see
Analyzing Downloaded Files.

Displays events for an alert and metadata associated with a specific event.

88 Show/Hide File Properties Panel. Click a row to show or hide the File Properties panel. It
displays the following tabs:

File Details - Displays the file information.

Hosts - Displays the hosts on which file activities are present. For more information, see Analyze
Hosts with File Activity.
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Hosts View

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The Hosts view provides a list of all hosts with an Endpoint agent installed. To access this view, go to
Hosts. By default, hosts are sorted based on the risk score.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoc Secan
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files
-Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

Analyze Events
(Navigate or Events [y
View)

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

Change File Status Remediate

[Optional) Isolate
Host from Network

What do you want to do?

T T R

Threat review hosts with highest risk score* Analyze Hosts Using the Risk
Hunter Score

Threat analyze hosts* Investigating Hosts

Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details* Analyze Host Details

Hunter

Threat search on snapshot* Search Files on Host

Hunter

Threat analyze processes* Investigating a Process
Hunter

Threat review reported anomalies* Analyze Anomalies

Hunter
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T T R

Threat analyze risky users* Analyzing Risky Users

Hunter

Threat analyze events*® Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT*, system dump*, or process Performing Host Forensics
Hunter dump

*Y ou can perform this task in the current view.

Related Topics

o Focusing on Endpoint Analysis

o Investigating Hosts

o Analyzing Downloaded Files

o Changing File Status or Remediate

« Investigating a Process

o Analyzing Events

o Performing Host Forensics

o Isolating Hosts from Network

Quick Look

Below is an example of the Hosts view:
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RSA  inesie Users  Hosts  File

Y Filters © endpointloghy... & Analyze Events | v || @StartScan 3 More Actions ~/ & D Windows10

HOST DETAILS
O wosTnamEe RISKSCORE & OS- DESCRIPTION LAST scAN TIME usERNAME AGENT LAST SEEN AGENT SCANSTA |G

100 Microsoft Windows 10 Enterprise  06/24/202021:30:33. WINDOWS10\ecat, .~ afewsecondsago Idie

»s Windows-security

2

ps Administrators

Intel(R) 82574L Gigabit Network..

=y 101252441
10.31.64.22,10.31.64.23

us false

@) custompare
Microsoft Windows 10 Enterprise

er 18362

Filter Hosts Y ou can filter the hosts by selecting the options in the Filters panel and create
filters. For more information, see Filter Hosts.

Actions in the toolbar:

Server drop-down list - You can select the Endpoint server or Endpoint Broker server to view
the hosts.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

Start Scan - Starts a scan for the selected hosts.
Stop Scan - Stops a scan for the selected hosts.
More Actions - Provides options to:

o Reset risk score.

o Delete - Lets you delete hosts manually from the user interface. After deletion, the Endpoint
server does not process any request from this host. For more information, see Delete a Host.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process

Memory Dump.
o Isolation host from the network. For more information, see Isolating Hosts from Network.

Note: You can perform the above actions from the right-click context menu.

LI Sort Columns. Lets you sort on column titles.

Bl Export to CSV - Extracts host attributes to a CSV file. For more information, see Export Host
Attributes.
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Rl Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

(B Show/Hide Host Properties Panel. Click a row to show or hide the Host Properties panel. It
displays the following tabs:

Host details - Displays the host information such as Network Interfaces, operating system,
hardware and others.

Risk details - Displays the distinct alerts associated with the risk score.

Al View Agent History - Displays the list of commands issued to the agent. For more information,
see View Agent History.
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Hosts View - Details Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The Details tab provides details of the selected host. To access this view, go to Hosts view, and select a

host.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoc Sean
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files
- Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

What do you want to do?

Analyze Events

View)

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

[Optional) Isolate
Host from Network

(Navigate or Events [y

Change File Status Remediate

T T R

Threat review hosts with highest risk score* Analyze Hosts Using the Risk
Hunter Score

Threat analyze hosts* Investigating Hosts

Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details* Analyze Host Details

Hunter

Threat search files on host* Search Files on Host

Hunter

Threat analyze processes* Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies

Hunter
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T T R

Threat analyze risky users* Analyzing Risky Users

Hunter

Threat analyze events*® Analyzing Events

Hunter

Threat download files for deeper analysis Analyzing Downloaded Files
Hunter

Threat perform external lookups Launch an External Lookup for a
Hunter File

Threat change file status or remediate Changing File Status or Remediate
Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT#*, system dump, or process Performing Host Forensics
Hunter dump*

*Y ou can perform this task in the current view.

Related Topics

o Focusing on Endpoint Analysis

Investigating Hosts

Analyzing Events

Performing Host Forensics

o Isolating Hosts from Network

Quick Look

Below is an example of the Details tab:

01/02/202002:32:50 pm

Lie A ES  DOWNLOADS  SYSTEM INFO HISTORY

olled over due to retention policies or manual deletion will not be available.

01/03/202007:13:12000am  Endpoint  ProcessEvent  createProcess  Win101511x64  WIN101511X6d\ecat  windows

C\Windows\System32\ 2
C\Windows\system32\
N Administrators,Remote, Desktop,

Agent and Scan Details. You can view the following agent and scan details of the selected host:

NetWitness Endpoint Reference Materials 102



NetWitness Endpoint User Guide

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.
Operating System - Operating system on which the agent is running (Linux, Windows, or Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping Scan.
For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

Analyze Events - Lets you investigate a particular host, [P address, username, filename, or hash
to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

o Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

« Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process Memory
Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Search files on host. Lets you search the files on the host (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host,

Show/Hide Right Panel - Displays host and policy details panel.

Host Details Panel - Displays all properties of the selected host. It is grouped as follows:
Groups - Groups on which the host is added on.

User - Information related to the user.

Network Interfaces - Network adapter information, such as Mac Address, Gateway.
Operating System - Operating system version and build information.

Agent - Agent-related information, such as agent ID, driver error code, install time, and agent
mode.

Hardware - Information related to the architecture.

Locale - Time zone and language that is local to the host.
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il Policy Details Panel - Displays the following:
« Policy Status -
o Updated - Host has the latest policy.

« Pending - Policy is resolved but the latest policy is not updated on the host. When the host
communicates with the Endpoint server next time, the latest policy is applied if there are
no errors.

« Unavailable - Hosts that belong to previous versions, such as NetWitness Platform 11.1 or
11.2, or the source server is not installed.

o Error - Problem applying the latest policy along with the error description.
Blocked Hashes Status -
o Updated - Host has the latest blocked hashes.

« Pending - Hashes are blocked but the latest hashes are not updated on the host. When the
host communicates with the Endpoint server next time, the latest hashes are applied if
there are no errors.

Evaluated Time - Time when the Endpoint server evaluated the policy.

Relay Server. Displays the Relay Server details.

o Server - Host name or IP address of the Relay Server.

o Port - Port number.

o HTTP Beacon Interval - HTTP beacon interval value in minutes.

« Complete resolved policy settings. For more information, see "Managing Policies" in the
NetWitness Endpoint Configuration Guide.

Note: The values that are not set in the policy are not displayed.

Alerts Severity - Displays list of distinct alerts, such as Critical, High, Medium and All, along
with the total number of events associated with the alert.

g Displays events for an alert and metadata associated with a specific event. For more
information, see Analyze Hosts Using the Risk Score.
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Hosts View - Process Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The Process panel provides a list of processes running on the host. To access this tab, select a host from
the Hosts view and click the Process tab.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoc Secan
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files
-Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

Analyze Events

View)

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

[Optional) Isolate
Host from Network

(Navigate or Events [y

Change File Status Remediate

What do you want to do?

T T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts

Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details

Hunter

Threat search on snapshot* Search Files on Host

Hunter

Threat analyze processes™ Investigating a Process

Hunter

Threat review reported anomalies Analyze Anomalies

Hunter
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T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events*® Analyzing Events

Hunter

Threat download files for deeper analysis™ Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*Y ou can perform this task in the current view.

Related Topics

o Focusing on Endpoint Analysis

o Investigating Hosts

o Analyzing Downloaded Files

o Changing File Status or Remediate

« Investigating a Process

o Analyzing Events

o Performing Host Forensics

o Isolating Hosts from Network

Quick Look

Below is an example of the Process tab:
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

« Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

o Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you select the snapshot
time from the drop-down menu.
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Actions in the toolbar:

Analyze Process - Lets you perform process analysis to investigate a particular process
behavior, and understand the entire process event chain, process parent-child relationships, and
all associated events. For more information, see Investigating a Process.

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, I[P address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
o Perform external lookups.
o Download files to server, save a local copy, and analyze files for deeper analysis.

o Download process dump to server.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host,

Toggle. Lets you toggle between List view and Tree view.

Process panel - Displays process information, such as process name, local risk score, global
risk score, On Hosts, reputation status, file status, and others.

Show/Hide Right Panel - Displays the following properties of a process in the right panel:

« File Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).
Time - Time when the file was created, modified, or accessed.
Location - Location of the file.

Process - Details of the process, such as image size and PID.

Image - Image details loaded by the process.

o Local Risk Details - Displays the alerts associated with the local risk score, such as
Critical, High, Medium and All.

o Hosts - Displays the top 100 hosts based on the risk score on which the file is present.

gl Filter Files. You can filter processes by selecting the options in the Filters panel and create
filters. For more information, see Filter Host Details.

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference,
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Process Details
Clicking the process name displays the process details of a specific process as shown in the following
figure:

R SA Inve : gle U Hosts Files

H AGENT LAST SEEN AC ON
: SN HOT TIME  06/24/2020 21:30:33
100 windows afewseconds ago ”—

DETAILS PROCESSES AUTORUNS L = DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY

< Processes | Process Details

PATH

C:\Windows\System32\

I

Process Name of the process. For example, server.exe,

Name

PID ID of the process. For example, 492.

Path Path of the file associated with the process on the disk. For example,
C:\Windows\System32.

Launch Command line arguments passed to the process when it is launched. For example, -k

Arguments LocalServiceNoNetwork.

« List of loaded libraries for the selected process, such as DLLs (for Windows), Dylibs (for Mac), or
.SO (for Linux).
« List of autoruns (if configured).

o List of image hooks and suspicious threads (for Windows).
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Hosts View - Autoruns Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The Autoruns panel provides a list of autoruns, services, tasks, and cron jobs running on the host. To
access this tab, select a host from the Hosts view and click the Autoruns tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoe Secan )
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Libraries, Processes, Drivers, Files Perform Host

Forensics

Review Hosts with

Highest Risk Score Remediate

Change File Status

-Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate
Host from Network

- Analyze Risky Users {Users View)

What do you want to do?

T T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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T T

Threat analyze risky users

Hunter

Threat analyze events*®

Hunter

Threat download files for deeper analysis*
Hunter

Threat perform external lookups*

Hunter

Threat change file status or remediate*
Hunter

Threat filter files

Hunter

Threat 1solate host from network*

Hunter

Threat download MFT, system dump, or process
Hunter dump*

*Y ou can perform this task in the current view.

Related Topics

Focusing on Endpoint Analysis

Investigating Hosts

Analyzing Downloaded Files

Changing File Status or Remediate

Analyzing Events

Performing Host Forensics

Isolating Hosts from Network

Quick Look

Below is an example of the Autoruns tab:

ME  06/24/202021:30:33

V Filters x ||Autoruns  Service

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded Files

Launch an External Lookup for a
File

Changing File Status or Remediate

Filter Host Details

Isolating Hosts from Network

Performing Host Forensics
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

« Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

o Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
o Perform external lookups.
o Download process dump to server.

o Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host,
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VBl Details Panel - Displays the following tabs:

o Autoruns - Files that are executed at start-up.

o Services - Files that are running as a service for the selected host.

o Tasks/Cron jobs - Files that are configured to run as scheduled tasks along with the trigger.
S Show/Hide Right Panel - Displays the following properties in the right panel:

« File Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Autoruns/Services/Tasks - Details related to autrouns, services, or tasks.

Local Risk Details - Displays the alerts associated with the local risk score, such as
Critical, High, Medium and All.

« Hosts -Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

g Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.
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Hosts View - Files Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The Files tab displays all files on the host including the files deleted within last 30 days. To access this
tab, select a host from the Hosts view and click the Files tab. By default, it displays 100 files. To display
more files, click Load More at the bottom of the page.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoe Secan
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files

-Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users {Users View)

What do you want to do?

T e R

review hosts with highest risk score*

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

analyze hosts*

perform adhoc scan*

review host details

search files on host*

analyze processes

review reported anomalies

Analyze Events
(Navigate or Events [y
View)

Download Files for

Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

Change File Status

(Optional) Isolate
Host from Network

Analyze Hosts Using the Risk

Score

Investigating Hosts

Scan Hosts

Analyze Host Details

Search Files on Host

Investigating a Process

Analyze Anomalies
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T T R

Threat analyze risky users

Hunter

Threat analyze events™

Hunter

Threat download files for deeper analysis*
Hunter

Threat perform external lookups*

Hunter

Threat change file status or remediate™
Hunter

Threat filter files*

Hunter

Threat 1solate host from network*

Hunter

Threat download MFT*, system dump, or process
Hunter dump*

*Y ou can perform this task in the current view.

Related Topics

Focusing on Endpoint Analysis

Investigating Hosts

Analyzing Downloaded Files

Changing File Status or Remediate

Analyzing Events

Performing Host Forensics

Isolating Hosts from Network

Quick Look

Below is an example of the Files tab:

01/02/202002:32:50pm

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded Files

Launch an External Lookup for a
File

Changing File Status or Remediate

Filter Host Details

Isolating Hosts from Network

Performing Host Forensics

ondee
61411942119893155
2285K8
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

o Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

o Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
o Perform external lookups.

o Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search files on host. Lets you search the files on the host (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

All Files Available on Host - Lists all files (reported as part of scan and tracking) on the host.
By default, All Files Available on Host toggle is enabled for Windows and Mac.

Details Panel - Displays information, such as filename, local risk score, global risk score, on
hosts, reputation status, file status, package details and others.
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Show/Hide Right Panel - Displays the following properties in the right panel:
« File Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and All.

o Hosts - Displays the top 100 hosts based on the risk score on which the file is present.

B Clicking a filename lets you navigate to the Files view for further analysis.

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.

Note: In the Deleted column, a trash icon appears next to the deleted file. The Deleted
column is not displayed if you disable All Files Available On Host.

For more information, see Filter Host Details.

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.
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Hosts View - Drivers Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The Drivers tab lists the drivers running on the hosts at the time of scan. To access this tab, select a host
from the Hosts view and click the Drivers tab.

Workflow

Analyze Events
(Navigate or Events [y
View)

Analyze Hosts

- Review Risk Contributors

Download Files for
Deeper Analysis

- Perform Adhoe Secan

- Review Host Details, such as
Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files

Perform Host

) Remediate
Forensics

Highest Risk Score Change File Status

-Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate
Host from Network

- Analyze Risky Users {Users View)

What do you want to do?
_m
Threat review hosts with highest risk score* Analyze Hosts Using the Risk
Hunter Score
Threat analyze hosts* Investigating Hosts
Hunter
Threat perform adhoc scan* Scan Hosts
Hunter
Threat review host details Analyze Host Details
Hunter
Threat search on snapshot* Search Files on Host
Hunter
Threat analyze processes Investigating a Process
Hunter
Threat review reported anomalies Analyze Anomalies
Hunter
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T T R

Threat analyze risky users

Hunter

Threat analyze events™

Hunter

Threat download files for deeper analysis*
Hunter

Threat perform external lookups*

Hunter

Threat change file status or remediate™
Hunter

Threat filter files*

Hunter

Threat 1solate host from network*

Hunter

Threat download MFT*, system dump, or process
Hunter dump*

*Y ou can perform this task in the current view.

Related Topics

Focusing on Endpoint Analysis

Investigating Hosts

Analyzing Downloaded Files

Changing File Status or Remediate

Analyzing Events

Performing Host Forensics

Isolating Hosts from Network

Quick Look

Below is an example of the Drivers tab:

01/02/202002:3250 pm

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded Files

Launch an External Lookup for a
File

Changing File Status or Remediate

Filter Host Details

Isolating Hosts from Network

Performing Host Forensics

NWEDriver2303sys

6.423240674371836
2430K8

pe
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

« Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

o Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
o Perform external lookups.

o Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

Details Panel - Displays information, such as filename, local risk score, global risk score, on
hosts, reputation status, file status, and others.
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S Show/Hide Right Panel - Displays the following properties in the right panel:
« File Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Image - Loaded image.

Local Risk Details - Displays the alerts associated with the local risk score, such as
Critical, High, Medium and All.

o Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

gl Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

121 NetWitness Endpoint Reference Materials



NetWitness Endpoint User Guide

Hosts View - Libraries Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The Libraries tab lists the libraries loaded at the time of scan. To access this tab, select a host from the
Hosts view and click the Libraries tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoe Secan )
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Libraries, Processes, Drivers, Files Perform Host

Forensics

Review Hosts with

Highest Risk Score Remediate

Change File Status

-Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate
Host from Network

- Analyze Risky Users {Users View)

What do you want to do?

T T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events*® Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat 1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*Y ou can perform this task in the current view.

Related Topics

o Focusing on Endpoint Analysis

o Investigating Hosts

o Analyzing Downloaded Files

o Changing File Status or Remediate

o Analyzing Events

o Performing Host Forensics

o Isolating Hosts from Network

Quick Look

Below is an example of the Libraries tab:
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RSA n ] rts

100 wapsoTTiME  06/24/2020 21:30:33

e Idie afew seconds ago 11500

DETAILS ~ PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES ~ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY 2

Y Filters X | Libraries || ® ChangeFileStatus || 7 AnalyzeEvents i More Actions v

PROCESS CONTEXT FLENAME LOCAL RISK SCORE. GLOBAL RISK SCORE ONHOSTS  REPUTATION FILEsTATUS DOWNLOADED

FILE DETAILS

Blackisted
Blacklisted

Blacklisted

Blacklisted

Blacklisted

Blackisted Filename  sigc-20dll

Neutral Entropy  4.496548278504887
= 765KB

Neutral

e
svchost exe: 4532 Neutral
ed false

svchost exe: 4532 Neutral

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

« Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

o Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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6
7

Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
o Perform external lookups.
o Download process dump to server.

o Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

Details Panel - Displays information, such as process context, filename, local risk score, global
risk score, on hosts, reputation status, file status, and others.

Show/Hide Right Panel - Displays the following properties in the right panel:

« File Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).
Time - Time when the file was created, modified, or accessed.
Location - Location of the file.

Process - Details of the process, such as image size and PID.

o Local Risk Details - Displays the alerts associated with the local risk score, such as
Critical, High, Medium and All.

o Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.
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Hosts View - Anomalies Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

The Anomalies panel provides a list of image hooks, suspicious threads, kernel hooks, and registry
discrepancies running on the host. To access this tab, select a host from the Hosts view and click the
Anomalies tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoe Secan
Deeper Analysis
- Review Host Details, such as
Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host
Forensics

Change File Status Remediate

-Search on Snapshot

- Analyze Processes Perform External

Lookups

- Review Reported Anomalies
(for Windows)

(Optional) Isolate

- Analyze Risky Users {Users View) Host from Network

What do you want to do?
_m

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score

Hunter

Threat analyze hosts* Investigating Hosts

Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details

Hunter

Threat search on snapshot* Search Files on Host

Hunter

Threat analyze processes Investigating a Process

Hunter

Threat review reported anomalies* Analyze Anomalies

Hunter
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T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events*® Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files Filter Host Details

Hunter

Threat 1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*Y ou can perform this task in the current view.

Related Topics

o Focusing on Endpoint Analysis

o Investigating Hosts

o Analyzing Downloaded Files

o Changing File Status or Remediate

o Analyzing Events

o Performing Host Forensics

o Isolating Hosts from Network

Quick Look

Below is an example of the Anomalies tab:
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By

NWEDriver2303sys
6423240674371836
2430KB

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

« Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

o Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
o Perform external lookups.
o Download process dump to server.

o Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

Details Panel - Displays the following tabs:

o Image Hooks
o Kernel Hooks

o Suspicious Threads

o Registry Discrepancies

Show/Hide Right Panel - Displays the following properties in the right panel:
« File Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Image Hooks/Kernel Hooks/Suspicious Threads/Registry Discrepancies - Details related
to image hooks, kernel hooks, suspicious threads, or registry discrepancies.

o Local Risk Details - Displays the alerts associated with the local risk score, such as
Critical, High, Medium and All.

o Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
(M Clicking a filename lets you navigate to the Files view for further analysis.

gl Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,
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Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

Image Hooks

Image hooks found in executable image are displayed in the following columns.

Type

Local Risk
Score

Global Risk
Score

Reputation

Signature
Downloaded

Hooked
Process

Hooked
Filename

Hooked
Symbol

Type of the hook . Possible values are - inline, iat, eat, or exception Handler.

Risk score of suspicious or malicious activities performed by the file on a specific
host.

Aggregated score of all suspicious and malicious activities performed by the file
across all hosts.

Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown, Known,
Known Good, and Invalid.

Provides signatory information.
Indicates the status of the downloaded file - Downloaded, Not Downloaded, and Error.

Process in which hooks are placed.

Name of the file that was modified by the hook.

Symbol in which the hook is performed.

Kernel Hooks

Hooks found on kernel objects are displayed in the following columns.

Type

Driver name

Local Risk
Score

Global Risk
Score

Reputation

Type of kernel object which was modified. Possible values are:
objectlnitializer,basicObjectPointer, majorFunction, invalidObject, fastlO,
notifyRoutine, attachedDevice, device, miniPort, sdt, sysEnter, or type.idt.

Name of the driver which placed the hooks.

Risk score of suspicious or malicious activities performed by the file on a specific host.

Aggregated score of all suspicious and malicious activities performed by the file across
all hosts.

Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown, Known,
Known Good, and Invalid.
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Signature Provides signatory information.

Downloaded Indicates the status of the downloaded file - Downloaded, Not Downloaded, and Error.

Object Name of the object function hooked into.
Function

Hooked File Name of the file that was modified by the hook.
Name

Suspicious Threads

Threads whose service table was hooked are displayed in the following columns.

Start Address Start Address - Start address of the thread.
DLL Name Name of the DLL.

Local Risk Score  Risk score of suspicious or malicious activities performed by the file on a
specific host.

Global Risk Score  Aggregated score of all suspicious and malicious activities performed by the file
across all hosts.

Reputation Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown,
Known, Known Good, and Invalid.

Process File name and PID of the process in which thread is running.

Downloaded Indicates the status of the downloaded file - Downloaded, Not Downloaded, and
Error.

Signature Provides signatory information.

Thread ID ID of the running thread.

Thread Address of the thread environment block.

Environment

Block

Registry Discrepancies

Configuration settings and options on Microsoft Windows operating systems that are stored are displayed
in the following columns.
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Hive

Reason
Registry
Path

Raw Type
Raw Data
API Type
API Data

Name of the registry hive when possible, otherwise it displays the hive ID. Possible
values are: hkeyClassesRoot, hkeyCurrentUser, hkeyLocalMachine,
hkeyUsers, or hkeyPerformanceData,

Type of registry discrepancy. Possible values are: notFound, embeddedNull,
accessDenied, parentlsHidden, or dataMismatch.

Registry path that is affected. The value is separated by a @ character.

Value type found in the low-level parsing.
Value data extracted from the low-level parsing.
Value type from the Win32 registry API.

Value data from the Win32 registry API.

Hosts View - Downloads Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.4 and later.

The Downloads tab provides information about all downloads (MFT, files, system dump, and process
dump) performed on the host. To access this tab, select a host from the Hosts view and click the
Downloads tab.

Workflow

Review Hosts with

Highest Risk Score

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Scan )
Deeper Analysis
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files Perform Host

Forensics

Change File Status Remediate

- Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate

- Analyze Risky Users {Users View) e v—.
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What do you want to do?
User
Role
Threat review hosts with highest risk score Analyze Hosts Using the Risk
Hunter Score
Threat analyze hosts Investigating Hosts
Hunter
Threat perform adhoc scan Scan Hosts
Hunter
Threat review host details Analyze Host Details
Hunter
Threat search on snapshot Search Files on Host
Hunter
Threat analyze processes Investigating a Process
Hunter
Threat review reported anomalies Analyze Anomalies
Hunter
Threat analyze risky users Analyzing Risky Users
Hunter
Threat analyze events Analyzing Events
Hunter
Threat download files for deeper analysis Analyzing Downloaded Files
Hunter
Threat perform external lookups Launch an External Lookup for
Hunter a File
Threat change file status or remediate Changing File Status or
Hunter Remediate
Threat isolate host from network* Isolating Hosts from Network
Hunter
Threat download MFT, download files, system dump, or Performing Host Forensics
Hunter process dump*

*Y ou can perform this task in the current view.

Related Topics

o Focusing on Endpoint Analysis

o Investigating Hosts
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o Performing Host Forensics

o Isolating Hosts from Network

Quick Look

Below is an example of the Downloads tab:

AGENT ATUS AGENT LAST SEEN AG
Idle afew seconds ago 11

DETAILS R0C s | AUTORUNS  FILES DRIVERS  LIBRARIES ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

Y Filters x = Downlosds | SavealocalCopy | | DeleteFile 3

NAME TvPE size DOWNLOADED TIME SHA256 FILEPATH

dwmee &5K8 Wdayzazo HBAIZITASHAab22480e .

1097K8 L 20533168700628c2555040e ... —

14298 20daysa0 14a5R0526d09:096914 eee .

219M8 20dayzao NA

Equals

Equals

@) cusToMDATE
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

o Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

Isolation host from the network. For more information, see Isolating Hosts from Network.

Download MFT to the server. For more information, see Performing Host Forensics.

Download files to the server. For more information, see Download Files Using Full Path or
Wildcard.

Download System Dump to the server. For more information, see System and Process
Memory Dump.

Filter Files. You can filter downloaded files by selecting the options in the Filters panel and
create filters. For more information, see Performing Host Forensics.

Actions in the toolbar:
Save a Local Copy - Lets you retrieve the downloaded MFT and save it to your local file
system for further analysis.

Delete File - Deletes the downloaded MFT from the server.

For more information, see Performing Host Forensics.

View MFT Details. Click the filename to view the MFT details. For more information, see
MFT Viewer.

L] [ ] L[] [ ]

The table displays the following information:

File Name Name of the file that is downloaded. For example, VGAuthService.exe,

Type Type of file downloaded - MFT, file, memory dump.
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Downloaded Status of the download:

- Download successful
. - Processing the downloaded file

. - Errors including download failed

- Errors downloading one or more files in the group.
Size Size of the downloaded file.

Downloaded Time Time when the MFT was downloaded.

SHA256 SHA256 of the file.

Note: This is applicable only for files.

MFT Viewer

You can analyze the downloaded MFT using the MFT Viewer. For more information, see Analyze
Downloaded MFT.

Below is an example of the MFT Viewer:
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< Downloads

PROCESE

Y Filters

| AUTORUNS

MFT-C-WINDOWS10-2019-11-14T06-47-52-T77Z

ProgramData
Program Files (xB6)
$RecydeBin

FILES

Hosts

afew seconds ago

LIBRARIES

_‘
S
=
-

NAME

NWE-Trace-Oclc bt

NWE-Trace-Qaccrar

NWE-Trace-Oacctxt

NWE-Trace-0f&0.rar

NWE-Trace-0f80.txt

NWE-Trace-0alc bt

11400

ANOMALIES

DOWNLOADS

SYETEM INFO

CREATION TIME ($FN)

11/12/2019 07:02:03 pm

11/12/2019 11:54:16 am

11/12/2019 12:48:33 am

11/12/2019 12:08:39 am

11/11/201% 09:25:01 pm

11/11/201907:32-11pm

] Perflogs NWE-Trace-Oc44 - Copy.bt 49.8MB
Program Files

7 $Extend

11/11/2019 06:56:29 pm

NWE-Trace-1fc0.tet 85KB 11/11/2015 05:44:35pm

2l L NWE-Trace-Ocd.txt 0 bytes 11/1172019 05:43:31 pm

Documents and Settings

NWE-Trace-0c30.txt 1019KE 11/1172019 05:42:05 pm

System Volume Information

DataCollector01Lcsv 642.9KB 11/11/2019 05:03:16 pm

DELETED FILES

NWE-Trace-264¢ - Copy.bt 210MB 11/11/201% 05:02-52 pm

ALL FILES

o000 0 0 D 000D O 0 DB

NWE-Trace-264¢ txt O bytes 11/06/2019 09-38:24 pm

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter MFT.

Folder Details. Lets you view the content of the MFT.
Download File to Server. Downloads files to the server.

The table displays the following information:

Column Description
Name Name of the file. For example, dtf.exe,
Size Size of the file.

Creation Time ($FN) File Name ($FN) creation time.

Creation Time ($SI) Standard Information ($SI) creation time.
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Modification time ($FN) $FN modified time.

Modification time ($SI)  $SI modified time.

Access time ($FN) $FN access time.

Access time ($SI) $ST access time.

Update time ($FN) $FN updated time.

Update time ($SI) $ST updated time.

Full Path Path of the file.

Allocated Size File size on the disk.

Archive Indicates if a file is archived.
Compressed Indicates if a file is compressed.
Encrypted Indicates if a file is encrypted.
Hidden Indicates if a file is hidden.
Directory Indicates if it is a directory.
Extension Type of the file. For example, exe, pdf, txt.
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Hosts View - System Information Tab

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

The System Information tab lists the agent system information. To access this tab, select a host from the
Hosts view and click the System Information tab.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoc Sean
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files

- Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

What do you want to do?

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

[Optional) Isolate
Host from Network

Analyze Events
(Navigate or Events g
View)

Remediate

Change File Status

I

Threat Hunter ~ review hosts with highest risk score Analyze Hosts Using the
Risk Score

Threat Hunter analyze hosts* Investigating Hosts

Threat Hunter perform adhoc scan* Scan Hosts

Threat Hunter review host details Analyze Host Details

Threat Hunter search on snapshot* Search Files on Host

Threat Hunter analyze processes Investigating a Process

Threat Hunter review reported anomalies Analyze Anomalies

Threat Hunter analyze risky users Analyzing Risky Users

Threat Hunter analyze events Analyzing Events

Threat Hunter download files for deeper analysis  Analyzing Downloaded
Files

139 NetWitness Endpoint Reference Materials



NetWitness Endpoint User Guide

I

Threat Hunter perform external lookups

Threat Hunter change file status or remediate
Threat Hunter isolate host from network*
Threat Hunter download MFT, system dump, or

process dump*
*Y ou can perform this task in the current view.

Related Topics

o Focusing on Endpoint Analysis

o Investigating Hosts

Quick Look

Below is an example of the System Information tab:

RSA

100

windows

DETAILS ~ PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES A YSTEM INFO

Host File Entries

127001

=

Launch an External Lookup
for a File

Changing File Status or
Remediate

Isolating Hosts from
Network

Performing Host Forensics

1]

£ 06/24/202021:30:33

HISTORY

{1
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

o Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

o Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

o Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

System Information Panel - See System Information Panel.

System Information Panel

The System Information panel displays the following tabs:

Host File All network redirections written in the host file. For example, IP Address -

Entries 10.10.10.3 and DNS Name -
localhost, localhost.localdomain, localhost4, localhost4.localdomain
4

Network Network name of the shared resource (for Windows only). For example, Name -

Shares Admin$, Description - Remote Admin, Path - C:\, Permissions - None, Type - disk,
special, Max Users - 4294967295, Current Users - 0.

Security Installed security products (for Windows only). For example, Display Name -

Products Windows Defende r, Instance - D68DDC3A-831F-4FAE-9E44-DA132C1ACF4 6,

Features - Enabled, Type - antiVirus,
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Windows List of patches applied by Windows update (for Windows only). For example,
Patches KB2959936,

Security Security configuration details on the host. For example, firewall disabled or enabled,
Configuratio  smart screen filter disabled or enabled. This field is only applicable for Windows and
n Mac.
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Hosts View - Agent History Tab
The Agent History tab lists the commands along with the respective status and additional details.

Quick Look
Below is an example of the Agent History tab:

Hosts Files

RSA  investigatc  Respor
@ WIN81x64-1 & : AGENTSCANSTATUS  AGENT LAST SEEN AGENT VERSION

Idle afew seconds ago 11500

DFTAIIS  PROCFSSFS ~ AUTORUNS  FIIFS  DRIVIRS  [IBRARIFS  ANOMAIIFS ADS  SYSTEM INFO  AGFNT HISTORY

Y Filters « | Agent History

HOST NAME COMMAND TIME COMMAND TYPE USER NAME
COMMAND TIME @) custompate
04/24/202007:03:34 am Sean admin
04/22/202009:29:38 am Reset File LogBookmark admin
COMMAND TYPE
04/22/202008:12:41 am Download File admin
04/22/20200 Reset File LogBookmark
04/21/20200¢ Download File system
04/21/202009:33:03 Download File system
REQUEST TYPE 04/21/20200 Download File system
04/21/20200 Download File system
04/21/2020 06:26:02 pm Download File system
COMMAND PARAMETER
Caitefrs 04/21/202006:26:02 pm Download File system

04/21/2020 06:26:02 pm Download File system

[ mea ] P —

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.
Operating System - Operating system on which the agent is running (Linux, Windows, or Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

« Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

« Isolation host from the network. For more information, see Isolating Hosts from Network.

o Download MFT to the server. For more information, see Performing Host Forensics.

« Download System Dump to the server. For more information, see System and Process
Memory Dump.
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checksum).

gl Details Panel- Displays information, such as:

+« Command Time - Command issued time.

o Command Type - Type of the command (Identity, scan, stop scan, download file, MFT,
process dump, system dump, start isolation, update isolation exclusion list, stop isolation,
reset file logbookmark, and download multiple files) issued.

o User Name - User who issued the command. For example, Analyst, System.

« Status - Status (success, pending, expired, failed, or cancelled) of the command issued.

o Command Parameter - Parameters associated with the command. For example, Command

Search files on host, Lets you search the files on the host (file name, file path, and SHA-256

Note: If the command's status is expired, it means that the agent is unable to process the
command even after five retries.

parameter for command type Download File is path = C:\Windows\System32\ |
filename = cmd.exe | hash =
6£88fb88ffb0£f1d5465c2826e5b4£523598b1b8378377c8378ffebcl71badl8b

Note: Command types such as identity, scan, stop scan, stop isolation, system dump do not
contain any associated command parameters.

¢ Processed Time - Time at which the command is completed, pending, expired, failed, or
cancelled.

« Last Retrieval time - Last time when the command is issued to the agent.

« Total Retrieval - The number of times the command is issued to the agent.

Note: After you upgrade to NetWitness Platform version 11.5, the commands executed in the
previous versions are displayed automatically. The fields such as last retrieval time, total
retrieval, and user do not contain any values. For system generated commands, the user field
value shows as system.

information, see Filter Host Details.

Filter Files. You can filter commands by selecting the options in the Filters panel. For more

Settings Menu. You can set History view preferences by selecting columns from the Settings
menu.
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